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f+4 & Code Composer Studio?

o THR A ZUALHE 28 1 42 1 T & 348 5% (1DE)
— RIS, gnikds, DS, BERSG, &%
— IDE3ETEclipse JT U5 A HESE (v4+)
— WA TTIR&ENS RS DR

« CCSV5EdE T [ Eclipse
— CCSAfi H A& 4 1M Eclipse it A4S
o TIERF 42 ) AR X 3 AT ek

— FH 7wl DABE & PR AR LA ) 7 (9 Eclipseddi /4 BT 1 T 24 i 2 B A (1)
Eclipsedf 55

— F ey PAE 2 B Eclipse T B8 I st By i i) 5 A

o HERESN T H
— BERGHINHRE T A LE (Linux#E/F R4, Androidff)...)
— ARBE A3 AT,  YRARRE HE ..
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Code Composer Studio v5

« CCSV573 AN Bt

~ 5.0
« NEA T HACCSv4
o BN EAE RS AT Linux i 5 22 4% C600011 FH 1
o BEHN T —EEFECCSVA LA HILinux ) TR I A
« O HCCOVE.IHAR, AFHFEAEEARIFF

~ 51
o B XTCCSvAR N, 1l IH Fra -

« ZFFWindowsHILinux
— R, JHEErA RS (emulator) 1 Linuxhi sC
» SD DSK / EVMHR#ifj H.4%, XDS560 PCI¥H L HF
— KZHIMUSB | LANTG B 3B 7 FF
« XDS100, SD510USB/USB+, 560v2, BH560m/bp/lan
— HTTP: [/ processors.wiki.ti.com/index.php/ Linux_Host_Support
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Code Composer Studio = fh 4R &

CCSv5.1

*Eclipse 3.7 (Indigo)
*Windows & Linux
«iYf{CCSv4 & CCSV5.0 T R
< CFRITA B (F24xXBR41)

CCSv5.0

No mor releases

CCSv4

*Eclipse 3.2 (Callisto)
*Windows only

| 424

R IEE -
T NEMBER
| | | | I

| 425 4.2.x No more releases

( ) In Development
‘ | Production
_) Early Adopter

{ ) Future

Current ! Sept Oct Nov Dec 1Q12

2012 |

2H12

I
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What’s New in CCSvS




] P X CCSvAR) [ 1t

o T ELEE /)N
— CCSDVDWHE KK (F#> 1GB, 3E4AGB)
— T N R 2 A B AR P

— CCSLL#R 2%

— 5 B TE] R R R i N3 B AR
s TRE Y

— M P Stk TR

— AR e H ] a6

« Rk, XF5.100 HErEfECCS B /N, FEP, HiE 5>
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B /N

o CCSv4x
— F#EK/NEL1.2GB
— AU K/NBRANNCDVD BB s I, P& T 3 54
— FHP 20T 28R PN 2 I At AT T ) e 22

« CCSVE.U1IHBIA Mk
— H P AR e A
— R PR RE, AN AR gt | O E 38l
— H P AT BUAE LS ds INSE 2 1 2 R
— B H P AT DL R T e #E 1 DVD S
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ER

o PR AT S5
— JA3)CCS
— Ja 8 & 15 (Debug Session)
— Gl EH (R PIPIEARE)

o Wi NIH
— HiP(Stepping) (AESATAREIFT H RS H)
— e, Fik (Expressions) F1Z:& (Graph) 4K )% 4E
il 5T
— 17 HASEC B (Target Configuration)
— IR T INAF
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1) 5 H P A

o [ oA
— BRUTEOL T, CCSHEFT JT i B A
— TR RIE T, TR P S

£V

— T 9 4 (CCS Edit) F11#1:{(CCS Debug)iZ L&l (perspective)

— fRfb LT (build options)
o A
— i FH BRI FIEclipseiZZAL & (perspective)
— JEH KA T-CCSv4
— e AT N Eclipsedifif: 21 IDER FH - 4

o ALY
— F P AT LA PR S S TR ot 7 D 46t
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). { =

W HZ)he

o AIEFT I H
— WAZBLREAR Y Tl A PSR G o0 A A v 4 8 T

o I
— VFZH A <Rtk 1 (build options) % i HEAR MEAd T, eI Iy
— IRTTH R T FE T G PR WA T AN JE CCS FH B 5T

o« =T H

— iy B R IS I, RS ] CRIRZ A I H D
— B R TT R A R R 24T TR AL
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B AR

« JifH
— FE A LR 2 S N IDE N &B V5 1l 2 5 3 B R 48
— Eclipse AT B b 2t 47 25 &

« FEPHNE
— — /MBI !
— TSR
— Flash A 1) e 42
— DA R R o

13 TEXAS
INSTRUMENTS




CCS5.1 B35 vl
Eclipse
—  HEEclipse &.CDT (C/C++ Development Tooling)
—  AF A<= Eclipse MICDT
TRl
i ML (Perspectives)
—  PLE(Views)
— G H
— B 7E YR (Linked Resources)

i H & B AR A
A 221k

Linux>Z
—  Linux=ZEHL(host) > HF
—  SCFrLinuxifil (RN D

%2 WAZ IR
ARG Hrds ( System Analyzer )
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Eclipse ) 58 375 &t

« CCSvV5.11f HII¥IEclipse3.7, CCSv4{ii HEclipse3.2
— SAFE[H] )18 52 A0 1 5

o JBEIH

— YA, KR4 (Editor/Indexer) i3
o fECCSvAHPH TLIFIEclipse X 38 AH 5% 1Y r]
« FHR
o B A[EE

— B HF

— RO . CRIRR AR T H D

— AR

— MEclipse N ## & #if4:

— S AT AR B B SR
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3 Fl R B SR A B Eclipse

« CCSV5 2T i it I ECclipse
— A AR MR AS I Eclipse
o TIE AT S5 A 2 FF YR AL X
— TIXtEclipse ] i ik = 451]
» FT 22 A U1k 2 15 A 1 1 S 45
» A PR AR B e 78— MR 1k _E R 3
» 7E 1AL Bl 25 CPU 73 4
» 25 T UL B BE R 1 2 IR gk GASINSE 2 1981, 658
o AR B T R Eclipse i {44 i 2L AT X Eclipse Ff 1
— UM EClipsedd@ifh K S Ak

o P a] LU H Eclipseft) B A Bod h g et
— BEIN 558 2158 (1 Eclipse
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£ I

File Edit View MWNavigate Project Tools Scripts

ellpfe o

Window Help

iC-ER iR i P 4 | B cos Ed | ¥ csDebug
QjProject Explorer &2 | = <§'> s (] & | [T] c_int00() at {sim{sds12scratchjcwolf _rtsbuild_dflemp2631.dal.design.ti.com_27278_linux{c60_rts/. fboot.c:57 Ox4a0 |
= am9 1
#1=5 foo 2 int a = 0;
5 helloworld 3 int b = 0;
15 helloworld_CCS 4 int ¢ = 0;
#1=% helloworld2 5
1 java & int add{int x, int y) {
# 1= pda 7 return x+y;
8 }
S
10void main(void) {
11 int x2 = 0;]
12 int y2 = 0;
13 int z2 = 0;
14
15 for (;:) {
16 at+;
17 h=h+2:;
18 c=addia,b)
12 xz2=a;
20 v2=h;
21 z2=c;
22 }
23
24}
25
[ Problems 23 T
0 items
t_)es;ription -~ Rgsource Path Loca... Type
i g*  Licensed Writable Smart Insert | 11:16
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TP E - LB (Debug View)

HI, T, 2 e I
BAT WM LR

A “CIO/ H#5”(ClO/target) sz 1 /4

“Ii H/H brlc & (Project / Target Configuration )17 &~ H#: #7852 1"CPUK %%

AT L i SR R O 2 JTAG 2 R 45
AT LA B AT AR AR AR (T )

%% Debug I 11 2R WS Y 70

= &'el CEETFEEWM_SDSE0VET. coxml [Code Composer Studio - Device Debugaging]
=g

maing) ak main.c: 94 0x008034F0

_C_ink00¢y at book,c; 173 0x0080904

x@ Spectrum Digikal x0asa0YE 5TM TRAVELER Emulator_DfCaaxx_1 (Disconnected ;
x@' Spectrum Digikal XDasa0YE STM TRAVELER Emulator_DfCaaxx_2 (Disconnected ;
x@ Spectrum Digikal XDasa0Y2 5TM TRAVELER. Emulator_DfCaaxx_3 (Disconnected ;
;.(‘E' Spectrum Digikal XDa560Y2 5TM TRAVELER. Emulator_DfCaAxx_4 (Disconnected
;.g@ Spectrurn Digikal ¥Da5a0Y2 STM TRAVELER. Emulator_DfCaaxy: 5 (Discannected
x@ Spectrum Digital xDSS&0MZ STM TRAYELER. Emulator _0fC66:xx_6 (Disconnected ;
x@ Spectrum Digital XD3S&0YZ STM TRAYELER. Emulator_0fC&6:xx_7 (Disconnected ;

nknowm)
nkmowm)
nknowm)
nknown
nknowm)
nknown
nknown

I
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i 4LBr A [0-F - — T SERR

CCS Project

Create a new CCS Project.

Project name: | Hella|

Zukput bype: |Executab|e

Ise default location

Location; | CATHworkspaces|\S1RIT2 \Hello Browse, .,
Device
Family: 5500
‘ariank: | <select ar bype filker et = |EVM5505

Conneckion: |Te><as Instrurnents X03100v2 USE Emulator

¥ Advanced settings

w Project templates and examples

| type Filker bext Simple Hello World executable application
printing the string "Hello World!" to standard

E Empty Projects oukput,

E Empky Projeck - ) o

. E Empty A i b Proiect Alkhough this is a simple example, it is nok

: MpLy AssEmbly-only Froje recommended For devices with small memary
= Basic Examples -maps {such as the MSP430 or C2000 Families
; e E Hello World of devices),
E D3PBICS 5. xx Examples
E IPiC and 1) Exannples

E--- Multicare System Analyzer (LTA)

@ = Back ek = L Finish [}i[ Cancel ]
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BB E

8- % P e
Fia) P = ‘5 7 = O (/) TI Resource Explorer &3
== In:u:I_tEe::tk

[ InclE Packages: welcome

By %5, 005D
@ 5IC
: File Edit ‘iew Favoribes Tools  Help
() Back - T O Search [ Folders | & (3 x E) [

- address |[0) CATHBSL_CSLY 10163154 _AMISx:x_BSL\testslexperimenterticd) s

r” Fll Ch=psinyg

Select how Files should be imported inko the project:

() Copy Files
() Link to files

Create link locations relative bor | PROJECT _LO0C

=

Configure Drag and Drop Setkings, .

®@

Lﬁ ok || cancel |

;i‘ Mowve the selected items
[ Copy the selected items

&N Fublish the selected items
ko the Weh

£=1 E-mail the selected items
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RWEHS - F0E

File Edit WYiew Mavigate Project Run  Scripts  Window Help
i EE IR %P IE | B cesede |
@TI Resource Explarer &3 l =& |
-l
Packaqges: &l L Devices: Al | Tapics: ol -
g
|Example Projects | URL: |
—
=% controlsUITE [~ 4]
D‘ Devices % -
=% Piccolo Fz802x % CP U T’m er
E";"} Example Projects
----- (= Wiew all 35+ example projects ) ) i
..... 5 aDC s0C Example program which configures CPU Timers 0, 1, and 2, and increments a counter
..... =4 L Timer each time the timer asserts an interrupt.
----- =5 eCAP Capture PWM
----- &m& ePWHM Timer Inkerrupts
----- g SCI Echoback . . . .
_____ 1S GP10 Setup These are the steps to import the project, build the project, and debug the
=% piccolo F2a03x project.
-8 Example Projects
----- = Wiew all 45+ example projects i i
..... S e soc Step 1. @@mport the example project into CCS
----- =5 CPU Timer )
..... 5 eCAP Capture PYWM Click on the link above to import the project. The imported project is available in the
..... & epyiM Real Time Tnterrupts Project Explorer view, expand the project node to browse the imported source files.
..... 5 PWM Timer Interrupts To modify source code, double clicks on the source file within the project to open the
_____ 1S 51 Echaback source file editor.
----- & GPIO Setup ) ) )
8% Daffine F2633¢ Step 20 | Build the imported project
E|°l."} Example Projects
""" (= Wiew all 45+ example projects To change build options, right click on the project and select Properties from the
----- = ADC 50C context menu. To build the project, select the link above, or select the Build toolbar
----- 2 CPU Timer button, or select the Project | Build Project menu item.
----- 55 eCAP Capture PWM
""" T ePWM Timer Inkerrupts Step 3: T, Debugger Configuration
----- &m& SCI Echoback
b @ GPIO Setup Connection: none
=% Deffino C2834x V] Click on the link above to chanae the device connection. Additionallv. this ootion is V]
) T 5] )
i © Licensed = B
I$ TEXAS
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File Edit Y“iew Mavigate Project Run  Scripts  Window Help

il i 1= T R

ZEEDD

-l Tncludes

-y 28027 _Ram_nk. cond

- DSP2E0ZY_CpuTimers.c
- DSP2a02y_Defaultlsr.c
- DSP2a02y_GlohalvariableDefs.c

- [§) DEPzE0Z:_Piecti.c
- [§) DEPzE0Z:_Pievect.c
- [§) DEPzEDZ:_SysChrl.c
@! DSP2E02x_usDelay. asm

@ Example_Z802xCpuTimer.c
=

& - E B - -G

[ DSP2E0Zx_CodeStartBranch,asm

- [ DEPFAENZ_Headers_nonB1os, cond

\ g conkrolSUITE_DSPZ802x_HeaderFiles_ //

r\.ij Projs Dlorer 3 . - @ TI Resource E:
fi— Example_Z80ZxCpuTimer \

Npackages: [ [ cevees: Torics:

xplorer 3 l

|

e

A |
|Ex\ple Projects ‘ URL: |
=¥ cantralsUITE ] ]
i Devices - ]
-4 piceolo F2802x % CP U T‘ mer
=% Example Projects
[ Wiew all 35+ example praj
15 ADC 50C Example program which configures CPU Timers 0, 1, and 2, and increments a
-5 CPU Timer counter each time the timer asserts an interrupt.
15 8CAP Capture PWM
15 ePMWM Timer Inberrupts
12 5CIEchoback . . . .
) % Gplocs:tu‘;c These are the steps to import the project, build the project, and debug the
=% Ficrolo F2803x project.
=% Example Projects
= Wiew all 45+ example praj .
1 ADC S0C Step 10 Slmport the example project into CCS ¢
5 CPU Timer
5 eCAP Capture PWM Click on the link above to import the project. The imported project is ['\\S
5 ePWM Real Time Interrupt available in the Project Explorer view. expand the project node to browse
125 ePWM Timer Inkerrupts the imported source files. To modify source code, double clicks on the
1 501 Echoback source file within the project to open the source file editor.
12 GPIO Setup . .
S 0 Delfing 2655 Step 2. % Build the imported project
=% Example Projects
[ Wiew all 45+ example proji To change build options, right click on the project and select Properties
S ADC 50C from the context menu. To build the project. select the link above. or select
155 CPU Timer the Build toclbar button, or select the Project | Build Project menu item.
e BCAP Capture P
f%:ﬁ BRI Timer Interrupts Step 3. T Debugger Configuration
1= 5CI Echoback
G g @
O -
E_( Problems 2% l ~ =8
0 items

Description &

Resource Path Location Type

O

3 ¢ Licensed
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ME: CCSv5 K24k

« IB7 5 (Breakpoint):
— HOH THERE AP e A DR e P T
— e, B R MR LR SC (debug context) H T A
— SRR R B YE R LR ICh, B o 2iE T W s

o Zifr#%(Register):
— MR (Grid) B SRy

o Argr(Variables) (V4 -> Local (M) ) FIZkiA=(Expressions) (V4 ->Watch CU%%) )
— XL ] O i 44 A BadfE (R Eclipse 44 FR
— FERIEAAE I8 In4s R AZ & (Add global variables) ¥ 2§
— Fikxk% 2 (Hex, Dec, Bin, Char)mJ LAZERR & 2 7)) if 3
— BRI PRI A 17

« R4 (Disassembly)
— I G s XS AR S
— AR RS R R0 BEOE L B AL R SR L
o i HEHER T
— IREERIR
« il (Console)
— AT F IR GIE1TGELA A (i F A= HI 4D
— H—Aulik CH OB G X T AHCPU (%L
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o “WE I H (Active project) s ik g BT H R X
— {E“TUH PHRE 48 (Project Explorer) siahi s — M H 25 H 3 H AR b “Active project”
— (EHRAEE RS E BT SCHIE BT s PR (Debug) e, Ko IR R JE — MR
[EII H RS 0
o (ETH 05 E PR DRI (OUH e LT
— TR H 200 B i i TR R AT AR
— YR R IH R TR

o “C/ C+ +Ii 5Pl 55 44 0 Tt H g B
o IH <% H A iy Ar E(Build Variables)
o ST H B FE

o ATRATH TIH WO H TN A R TR AR
CCSv4: i Bt Al ] — AN 2 B jardh AT Javask 56 B
> jre\ bin\ java -jar startup.jar<restOfCommand>
CCSv5: i F“eclipsec.exe” 8 “eclipse™
Windows : > eclipsec -nosplash<restOfCommand>
Linuxf#J: > Eclipse -nosplash<restOfCommand>
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o WAHAR (CTAEX) i <k i (Debugger Options)
o REFWRAE SCFRET4E” (pin) A« Cclone)

o ifid & (Debug Configurations)
— e A A SRS TR N 2T IR RAIas A (JavaScript3C )
- fft HHDSSHIUH4L H A5
o — NIRRT DAEZ A S viG 2 1~ CPU
o 1] LA H 5 s GEL 3L A
— TEFER TH A pRas B fe LLRE— > CPUMALTR /&

« CCSvA[1)«H ¥ (Target) s g v5 ) “iz 177 (Run) =& . Bt HU AR
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LinuxEPLSZF

FELL N A

— Ubuntu 10.04[1)321v

— Ubuntu 10.10132 / 64f7
— SUSE 11 3214y

CCSHASE T8 )% (BRI 73 A7 A 11 572

AR 1 D REAE Linux L #5A SZFF

— EREE (Trace)
- WIZERER (XDS560T)
o IR ARIREEZE M ( ETB (Embedded Trace Buffer) )
o RYIREARIEE ( STM (System Trace Module) )

B, JHARTE M B AsAE Linux L& S #r
— SD DSK / EVMH#; H4s, XDS560 PCIA S HF

KZHUSB/ LANI{) H 2% #0552 #F

— XDS100, SD510USB/USB+, 560v2, BH 560m/BP/LAN
http://processors.wiki.ti.com/index.php/Linux_Host_Support

I

TEXAS
INSTRUMENTS




Linux 7 % (B %)

o CCSYZHrWindowsHTLinux AL H i
o M4 K IGDBIE R Linux v FH A2
e JHILITAGHIALInUX N 1%

RS232

LAN
Gdb on CCS

Putty

LAN JTAG
CCs

&

LAN

Gdbserver on target linux
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Linux /A2 R

UGS BT EW AV E RG-S e ay e DA o T MO M PO S Eras T in BE
File Edit Wiew Search Project Tools Run Scripts  Window Help
- 2@ - &- Il Tl < R B |#5; ccs Debug | B Cs Edit
%5 Debug Sﬁl e e [ S o @& == E|| (9= ariables 57 | 67 Expressions | 441 Registers £ <k ?& X% Y —0O
BE GCC_sinewave_AS Debug [C/C++ Remote Application] Marne Type Yalue
W,

= I:Ii? GCC_sinewave_AS [cores: 0]
=g Thread [1]1810 [core: 0] {Suspended : Ereakpaint)

(9= howlongtosleep int 35052

E!@ AM3S1T _xds100wZ2, cooml [Code Composer Studio - Device Debugging]

El[@ Texas Instrunients ¥DS100v2 USE Emulator_0/Cortex_as_0 (Suspended)
trace_hardirgs_on_caller{unsigned long)() at lockdep.c: 2,319 0xC00AZEES
cpu_idle(y at irgflags.h:26 DxC0048394
start_kernel() at main.c: 703 0xC0008C50

0x50005034

@ TI Resource Explorer I@ sinewave_float.c &2 lﬁ main.c |E lockdep.c =

14float results2[SIZE_DATASET] : DJI

15unsigned int count = 0O; E

16

7int main (roid)

=R}

=l int howlongtosleesp = 1:

u]

1 printf ("Value of PI is: %£", PI):

z for (count = 0; count < SIZE DATASET: count++)

3 {

4 resultsl[count] = 02

=) results2 [count] = 0; =

3 i

7 for (count = 0; count < 3IZE DATASET: count++)

g {

9 datal[count] = 4 * PI * {(fleoat)count / 1024); al
Bl console &2 X % G &E @I@ = B - 7 8| &reminal EX]. MCSA Welcome &7 & B |1|_§| & g-x -0

GCC_sinewave_Ad Debug [C/C++ Remote Application] GCC_sinewave_AS Serial: (COM42, 115200, 8, 1, Mone, Mone - CONNECTED)

am351l7-evin login: root

rootBam35l7-evin: ~# gdbserver :10000 GCC_sinewswve 18
Process GCC_sinewave A58 created; pid = 1810
Listening on port 10000

Remote debugging from host 155.215.99.169

0% & Licensed
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EZ Y

. J55€—/NavaScript k4T 2 CPUI L
— JTAESACPULERATGEL <, INEFLR, 21T & v e fife

e R CPUTT LA AN 2 2 It 7 2
_Cosvaik AT HIAE R, VBT IR IGUIKE B H T

o %A “lHP R (Synchronous Mode )#% 4
— A n] LAgE Rk 2 B AI ) B L CPUA

AL T2 I A7 B 5 X.CPUZI

o« PR (Status view E ALK oA CPURPIR S E B CRLFE M i
7% (Crouters ) )
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AR e

o EARARTEITE], MIMFEAN RGN HFET, ARG R AE
o AR IAE AR R B DI 21— N4 Jeg R s A 4l
o RGBT AL H AL O AL ik
o UIA (UK R 45H) - Unified Instrumentation Architecture ) = H #piii H i 5%
(logging), iz47#Hll(runtime control) A% ¥ 1= 5/ (data movement) T. =249
o DVT (EdEo#rFm i b £K - Data Analysis and Visualization Technology ) : THliwiz
¥, % K4 (data collection), #i#kf#fid(data decoding), ds />4 (data analysis) A1 %k s

B R P AR CHET PGB RN B R e L

[ K . B S CEEE
[T S ST SR =] - LT e S a—— B R H
T A | Y A kL N e St [
v HAKRMIONAH O CAAF R LM e i CulAE, mrsommbo O, arvd Lk
i a Fams ConCEHAIHG [
e [
2w i o =
'E Bk ooy el "
i pedicn_lnci,
s e
i
Hoa i 1 -,
Jime fi

Foe bk o - P e s ] |
SIS A ORI Bk B e B, B -

®
w
+ a8
" K Ama B
]
ol ERT R awe Lot fevae] = [} [}
arebacices Ll - g A4 o g
] tnd PE M AR tas b
e g L M el R e -

PO | P —
B ket UL Ve © v A2t e L at b, L a -

ol
; i.m
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L& BICCSv5.1

« CCSV5.1
— B¥CCSv4
— HECCSVEYFTIE
o VT BT A0 P P 4 5 23 CCS V5.1
T T Bt B0 PR T LA SE T D SRS T %

I
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T

« M\CCSV3iE# F|CCSvAH — & XEJ&
— SEEANF A
— BHH &Rt
— H PR E (Target Configuration) 5 £4
— CCSHy#EAKIm H A AA—HF

« CCSv4 CCSV5.1iT 4 ifi15 £
— REEIEHAH R
— T H ARG EMER GRFE RS
— HFREE AR

« CCSv3 CCSV5.1iT#
— InamV3RIVER I H ) 5
— U A B 1 P 4a 8 5 > it 2
— TR0 SRS B AATTEE P &b

13 TEXAS
INSTRUMENTS




TBHFEIRF - CCSv4 -> CCSv5

« TAEX
— LEVSI A HTHT A AR

- IiH
- —AVAIH FABIVSE B, BEEANE FE VAT T
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Questions?




CCSv5SHITMS320F28069
controlSTICKA ]

Getting Started with CCSv5 and
TMS320F28069 controlSTICK




H4 RTMS320F28069 controlSTICK?

« Piccolo (JHEE) F28069%aHigs

o Pk, H{E, EBTIFFHEPiccolo
F2806xda il as I TR et ThRe, RES
39

« JF{EF 5 T1# A KcontrolSuite GUI

o PRALH 5 B S2E B RPiccolo F2806x MCU
KIFE RBE SN

- HgizZEERs X

- IREHTES, WUTHFE/OF M
o VREHHVE BT A SR

- STEEMAEGIRIEE], Gerber3Xf5%
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TMS320F28069 controlSTICK

MR ZUSB LED LD2 TMS320F28069
JITAGJ; K. (GFIOS4)

—

AN

TR

RTTTTTRNTTTTTT M ClE
Mastabgasiigairene U2

USBIJITAG LED LD1 Ahix
i3 Texas
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Wit < BH

» RRBHT SR MERMEATE SR &

BHIRE 2| “Let’s Do it” KB fr, BRFHAT —LAH N HI#RAE

1ETS
oIt

I
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A 4R LED ) Y54
BLINKING LED EXAMPLE




NIREILED: ZJBRE

- XEHW
— QAR A ] L R P blink LD2
— JA 3R T A N 2R > Bl control STICK
— &84T blinkLD2
- TEM#Z
— LAFIX (Workspaces)
— I R R FE 4% (Welcome screen / Resource Explorer)
— TH M
— LB LA
— Wil )E 3
— g
— S ds i B (Profile Clock)
— ARH
— P NI AU g 560
— ¥z )& PE(Build Properties)
— W Gm PR RA
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T

| %]

AW |

JB38ICCS, #EHE —NTIERX K
— BRI HIE R e

LV TS GCEN STITIGHET,
Select a workspace

Code Composer Studio stores wour projects in a folder called a workspace
Choose a workspace folder to use for this session

Warkspace:

—— [ ] Use this as the default and do not ask again

Browse, ..

Ik

] [ Cancel

i3 TExas
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Eclipseft&: T{EX (Workspace)

- CCSHIEETEHFK

- BEsdle XHAra T H K EE#E B
— DRI I A BRIA M 2

ST
eclipse

- P BRI (User preferences), B xE XHIZEFLE (custom perspectives),

{81 ZAFHE (plug-in cache), F%F, #AFMRELIEX

§ TEXBEEARFAE5CCOVBTER I (*. WKS) B

.« AJYERFZATAERX
— BEANCCSSAFN AT LA RIS T —A TAEX
— MR TAEXR AR Z A CCSHY Iz 17 5841
— AW P 2 WAL= TAEX

i
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vz A 10
¥ JE e 7 B Boir

[+ CES Editcaliiesonrcexplorers Code Composer Stugdio) JJ@
[ Eﬁykﬁm —/l\%f EQIW B: B‘j‘ File Edit \Jiiew Naviga:a ije:t Run  Scripts Wir:ﬂnw Hel; J
[13 v % %%”){%E —y14 k NEEl) i I SO | & cosedt
, “WIREH TN/ e S .

|/} TI Resource Explarer

£
ﬁ E [y Packages: Devices: Tapics: i & =

URL:

* %ﬂﬁﬁ*%CCS)\H%ﬁR Welcome to Code Composer Studio v5
You can bring this page up at any time by selecting Welcome from the Help menu
- BEICHEEEE, B, XFE

=3 <> Highlights
“ﬁ IL New Project v gnitg ‘

o READRAIE—AFHIE, B
SAABA T E TR \ _
t— Getting Started

+ AT DABER B - >Fil o
CCS”(Help->Welcome to CCS) )

+ Welcome to Grace

+ System Analyzer
+ C6EZFlo

DJttht
d

3 B V5 o |
@’ Web Resources R vmenw |

=

Licensed : C e Bl
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L -
eclipse

Eclipseit&: T{ES (workbench)

o I @ﬁ”%*ﬁjﬁgccs @ﬂéﬁ A CaS T (R i Go eI oE TS T D BEE
File Edit view Mavigate Project Tools Scripts  Window Help
ﬁﬁn, i K- BB PE &= | & cosedr |
@ [ main.c 2 =g

E\DPFDjEEt Explorer &3 = 4:;; ~ = O || @) TI Resource Explorer
M2 (14 i
— M TAECCS3 X Fhl |-
- [ Includes Z % main.c
(2] main.c 3 %

ﬁ I:] ,,(Co ntrol Wi ndOW) g Ink_msp43002231,cnd ;vnid main (void) {

T MSP430G2231, coxml [Active/Default]
6}
7

T IrA AT AN
KIS F L (view) 5 F IR 1

[ Problems 52 ¥ =08
0 items
Descri ipkian Resource Path Location Typ
[ licensed (S hinkED
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THES (5CCSv3xHLE)

- CCSHI3.XhR
— AR CPU H AT A — AT 320 &
— RN E E (Control Window) 2 8] {5 BANAEIL =

« CCSHj4/5

[

— AUFT I ZAD TAEES & I (5 107 - > 1) C'Window->New Window

)

- AN TAEG @ A LA ERAFE CHOLE , THEERNE 2 5 , Hi

of N [A]— N CCS 451 i f T AE X
o WN—ANTAEGHTIFRISE H ¥ Be 70 T4 (0 TAE A & 1 g 2

i
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-

N BRI B A R BLN T AT s B

i H
i W LB AT R D B

LE“controlSUITE - >kits - >
controlSTICK: Piccolo F28069”

e $%“Blinking LED Example”Jit H

185

TS
l OIT

o

CES Edit Tl

Lesolrice

Code G

ixploren

dpipusEr Jidia

A=

File  Edit

i}

Wiew Mavigate Project

Run  Scripts

- S

@ TI Resource Explarer &5

&

[ty | Packages: Al

Example Projects

=1 kits
=00
=

580

2 GPIO Setup

controlSTICK: Piccola F28027
4 Example projects
= View all 10+ example projects
é} Symrmetric P Example
é} Triggered ADC Example
é} Comparator Example
g Blinking LED Example
13 DC Mokor GUI Example
controlSTICK: Piccola F28069
L Example projects
= View all 13+ example projects
éé Symrmetric Py Example
éé Triggered ADC Example
s

ER

o8

controlCARD: Experimenter’s Kits

L Example projects
'g F2802x Flashing LEDs Project
'g F2803x Flashing LEDs Project
2% F2806x Flashing LEDs Project
25 F2833x Flashing LEDs Project
25 £2834x (DIM100) Flashing LEDs Proj
22 £2834x (DIM168) Flashing LEDs Proj

Mator: High-voltage Motor Control + PFC Kit
4 Example projects

(= Open example projects folder

2 ACK FOC Sensored

2 ACE FOC Sensorless

(v

: Licensed

Window Help

D Dievices:

URL:

| & cosed |

Topics:

P L
fay <=

L | o
‘|l:||:|\/ ™

B

Blinking LED Example

Blinking LED Example

These are the steps to import the project, build the project, and debug the
project.

Step 1-

Step 2:

Step 3

<]

&8 Import the example project into CCS

is aval

Click or ke above fi
the Project Explorer viey
source files. Tom
project to open

imported project

e source file edito

@ Build the imported project

select Properties from
. or select the Build

& projec

T Debugger Configuration

e the device connection. Additionally, this option

e nrnient nrmnerfies

® g

h
ER|
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F12: BACNLRLED(Blinking LED)

o mili“F ACCS/I I H
”(Import the example project
into CCS)¥iH:, &l PRI«
NERLED”(Blinking LED)Jit H
FACCSH) TAEX

o WERS ARG, 230 H R
HHIAE T H B A, JF
H—A et B ik hric & Hl
TERERRI 55, DARZS Jl

Heaguyes Bl = Guds Copfuosay iy

\9

\=

9

15
ot

AEE

[l Includes
(= ~Docs
] Binkingl ED-DevInit_F2806x.c
€] BlinkingLED-Main.c

[$ Fz808x_Codestarteranch.asm
[ & F2806%_FLASH_BlinkingLED.cMD
& Fz808x_clobalvariableDefs.c
[ F2806x_Headers_nonBIOS.cmd
[ F26082_RAM_BlinkingL ED.CMD
|= macros.ini_initial

) Licensed 0items selected

O CCS TN
File Edt View Navigate Projsct Run Scripks Window Help
£~ - e
=5

() T1 Resource Explorer 52

Packages: al

Example Prajects

[ Devices:

URL:

Topics:

| 5 ccsEde |

= GPIO Setup -]
=T kits
=4 controISTICK: Piccolo F28027
=% Example projects
(= view all 10+ example projects

Lé Symmetric PWH Example

Blinking LED Example

Blinking LED Example

= Comparator Example
= Blinking LED Example
12 DC Mator GUI Example
=4 controISTICK: Piccolo F28069
=% Example projects
B wiew all 13+ example projects
3 Symmetric PUM Example

{5 Triggered ADC Example H

b Comparator Example
Lé Blinking LED Example
{5 Sin FIR + FFT32 GUI Example Pr
=% controlcARD: Experimenter's Kits
=% Example projects
s

£ F2802x Flashing LEDs Project [

@II 5]
2 Problems 52
0 ibems
Description Resaurce

Step 1: & Import the example projectinto CC
g Triggered ADC Example
"
=
%

These are the steps to import the project, build the project, and debug
the project.

ecl, Ot

Step 2. % Build the imported project

Location Type
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Eclipset&: i H (projects)

o« T WS RSO R G I H %

o A LAV INER R S0 B 1 H
— NSRRI E
o SISO BT H o
— BRSO EIE
o EREIHE 5| HZ S
o SCHHE AR R ORI E
@ - CCS3xIMI H AT XA ST BN &

o TUH AT T ESR A i R A
— KHIMIH -
« PHETAEXH, (HEARH TG BN
« KRHIMIUH BHRASIMIHE TAE S, (EREVAER AU RS
« RHIMIH T ZBDBINAE, FEAS BRI T3
« EAFTFCCS3.xH, KM H A2 T BLAECCS3 I H ALK & H .

o T H WA SN TAEX J5 4 7 LLFT IF
— CCSv4/5, CCEMINH FLg:CCSv3 il H #)a] S A\ 3| TA/EX

» ..
eclipse
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Eclipseit&: LA

MEETAES & LN E I, eft—2F Bl it R os
— RZE A A LAESC S AL B (View) Hh 7 i)
— A LA FRZS (organization tabs) i i )

- .
eclipse

== Disassembly (main) £ Memory (1)

= O

/ Enter location here - | @ t:ﬁh S @| ||_'=‘{j =~
-~ . oL
CCFE7 SUBMAW.DZ Bl5,0x6,B15
nez7 MVE.LZ 0,B4
023C22Fe STW.D2T2 B4, *+3F[1]
ooo21ca: 023F332L MVE. 32 0xTe66, B4
00021CC: 023C220& STH.D2TZ2 B4, *+3F[4]
00021D0: 02125828 MVE. 31 0x24b0, A4
0xE800021D04: 02400068 MVEH. 51 0x20000000,R4
0xE800021D08: 423C LDH.DIT1 *h4[2],A3
0x80002104: 004c LDW.D1T1 *n4[0],R4
Eg230000 .Iphead n, 1, W, H, nobr, nosat, 1/
2637 ADDAW.DZ Bl15,0x4,B4
2CEE HOF 2
4235 STH.D2T1 L3, *B4[2]
n0ds STW.D2T1 L4, *B4[0]
CSDWSLS main$25B, C3L1:
0xE800021E2: 0ZBDZ22CE LDH.D2T2 *+5F[9],B5
0xE800021EC: 023C22Ce LDH.D2T2 *+5F[4],B4 -

« |

(LI
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P . T H R UES 8 (Project Explorer)

o WORPTA T AR e RIH

o TEGELICAF R G 2R 7m0 H ST ) Y 2%
— BRSO ARARAT — R IR (R B AR

o R LU ]I i A R BRI 25 B SRS, L/ AE AL PRI L
— BRIN &t ECCSA IR H S ()

L™ Project Explorer &2 = <,1=’=f> ¥ =0

= == BlinkingLED

it Includes

= ~Docs

@ BlinkingLED-DevInit_F2806:x.c

[ BlinkingLED-Main.c

% F2B806x_CodestartBranch, asm

4 F2806x_FLASH_BlinkingLED, CMD

@ F25806x_GlobalvariableDefs.c

4m F2806%_Headers_nonBIOS,crd
[€] Fza06:_RAM_BlinkingLED. CMD
|Z| macros.ini_initial
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B2 WE“NIFLED”

o 20, fdielEt s
A3 H > (Build the
imported project) &%, 14
<IN 4RLED”(Blinking
LED)Ti H

o« Mgt & (Console) fi
e HH B ISR, B I
H # 27H E

o WARMEE KT, g
(R bR o H AR B

TS,
“DoiT’

S CCS Edite I ResoTTeeskxplorer

St

Coppuszy Jigdio

File Edit View Mavigate Project Run Seripts ‘Window Help

[ Project Explorer 52

3+ A e

P A
ER-

= 575 BlinkingLED

4 Binaries

! Includes

= ~Docs

(= F2808x_FLASH

€] BlinkingLED-DevInit_FZ806:x.c
[£] BlinkingLED-Fain.c

%, F2806x_CodeStartBranch. asm
| & F2808x_FLASH_BlnkingLED.CMD
[, F2a06x_GlobalvarisbleDsfs.c
[ F2808x_Headers_nonBIOS. cmd
[ Fzs06x_RAM_BinkinglED.CMD
=] macros.ini_initial

: Licensed

(/)71 Resource Explorer £
Packages: 4l

Exampls Projects

s

% GPIO Setup
=¥ s

EE[x]

B | B cosedi |
=0
] pevices: Topics: G/_“j- \;3 =
LRL: [~]
@ =

=99 controlSTICK: Piccolo F28027

=% Example projects

(= View 8ll 10+ example projects
5 Symmetric PAWM Exampls

s

= Triggered ADC Exampls

w5

= Comparator Example

1 Blinking LED Example

15 DC Motor GUI Example
=-%% controlsTICK: Piccolo F2a0es

=% Example projects

5 Blinking LED Example

Blinking LED Example

(= view all 13+ example projects

s

=5 Symmetric PWM Example

5 Triggered ADC Exampls
5 Comparatar Example

s

1 Blinking LED Example

s

T S FIR + FFT32 GUI Excampls Pr

=% contralCaRD: Ex=perimentet's Kits

=% Example projects
i

5 F2802x Flashing LEDs Project

s

1= F2803x Flashing LEDs Project

s

T F2806x Flashing LEDs Project

s

DT Build Console [BlinkingLED]

5 F2833x Flashing LEDs Project (o)
Cee L

& ¢ [%] A 6B G

"../F2806%_FLASH BlinkingLED.CHD"

<Linking>

'Finished building carget:

FHEF Build Finished ##*+#

BlinkingLED.our!'

These are the steps to import the project, build the project, and debug
the project.

Step 1:

&3 Import the example project into CCS

above to import
e Project Explorer
ree files. To mod|
duileproiect to op:

T4 = O problems 52 - =8
0 items
2| Description Resource Path Loc
1
V|l

i | %]
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E

« ZA~ E R 3 (context)
— A LR R 2 (build) v S B (debug)il B CELEECIO) |, MU TP ik e sl &
— M ANF B BRI EEh b
« T LU 4T (pin) Bk s 11 5 Ak 6 1 21 e
® - cosaxch, WwEH, ClOf AR 7 B A LT 1R,
o EATT LT IT 2 AN 4 B
— B, A6 N.CIO RIS A g — X R Ay v R

$:45 & (console)

o0
4.3

= = =
El consale 2 R = i m |
blirkLED ﬁl DT Global Build Cansale
M5P430: Program loaded. Code S3ize — Text: 74 bhytes Data: 2 hytes Elz COT Build Console [blinkLED]
] 3 blinkLED
i3 TExas
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B=0: IBECGRASEKE” (Debugger

Conf‘igu ration)

o TEERID I CIERE
”(Connection) I VG 2 X
1 B

® j:'_’l\\\ k3ﬁ’ l\\\}:ﬁ‘I:—E‘“-[/ﬂ_[/itEa
‘& ”’(Debugger Configuration)%%

%

o —XUHER 2
B
P ““Texas Instruments
XDS100v1 USB Emulator”

SERKI, LEFE“OK”

HEL, B

Packages: 4l

G:l TI Resource Explorer 25

Example Projects

1= GPIO Setup =]

=¥ kits

=% conbrolSTICK: Piccolo F28027
-8 Example projects
== Wiew all 10+ example projects
'@ Symmetric PWHM Example
'@ Triggered ADC Example

'@ Comparator Example
'@ Blinking LED Example
b DiC Motor GUI Example
=% conbrolSTICK: Piccolo F28069
- Example projects

= Yiew all 134 example projects

'@ Symmetric PWHM Example

b Triggered ADC Example
'@ Comparator Example

b Blinking LED: Example
= Sin FIR + FFT32 GUI Example P

=% contralcaRD: Experimenter's Kits

- Example projects
'@ F2802x Flashing LEDs Project
'@ F2803x Flashing LEDs Project
@ F2&06:x Flashing LEDs Project
'@ F2833x Flashing LEDs Project
125 C2834x (DIM100) Flashing LED:
5

122 C2834x (DIM168) Flashing LED:
=% Matar: High-voltage Maotor Control + PF
=% Example projects
= Open example projects folder D

i) | B

D Devices:

URL:

Topics: '-U_ L]
DIR[0 A PO e eXdimpie projeci ing .o
nk above to import the project. The imported project is
in the Project Explorer view, expand the project node fo
browse the imported source files. To madify source code, double clicks
on the source file within the project to open the source file editor.
Step 2: @ Build the imported project

, click on the project and select Properties
“context menu. To ¢ the project, select the link above, or
select the Build toolbar button, or select the Project | Build Project
menu ifem.

@ T, Debugger C-:Jnfiguratioé?

ihe device connection. Additionally,
roject properties.

-
Salebupeenonfiguration; v ﬂ

ionnections:

Blackhawk PCISE0 Emulator
EBlackhawk PCIS60 Emulator, 20-pin ITAG Cable —on.
Blackhawk USE2000 Controller I
Blackhawk USBS 10 Emulator L
|CARD: Experirng Blackhawk USBS10L Emulator ug
Blackhawk USBSED Emulatar -
: Blackhawk USBSA0 Emulator, 20-pin 1TAG Cable

» F2802x Flashin Blackhawk USES60-BP Emulatar

. F2803x Flashir Blackhawl USESE0-EP Emulator, 20-pin JTAG Cable

i .| Elackhawk, USESE0-M Ermulator

7 F2806x Flashiny -\ hawk USBS60-M Emulator, 20-pin JTAG Cable

» F2833x Flashin| gl kbl ¥D5560v2-LAN Syskern Trace Emulator

» C283%x (DIM11Blackhavik ¥DS560w2-USE Mezzanine Emulatar

L C283% (DIML Blackhawk. XD5560v2-1ISE System Trace Emulator

) Data Snapshot Yiewer

High-+valtage M 2eectr m Digital C2000 XDSS10LC Emulator

ample projects |Spectrum Digital 05510 Parallel Port-PCT Emulakar
+ Open example| SPectrum Digital X05510U5E Emulator

Spectrum Digital X0S510USE-PLUS Emulator wia 152
Spectrum Digital XDS560v2 STM LAKN Emulator
Speckrum D|g|ta| ADSS60VZ STM TRAYELER Emulator

ample projects

&

[

wgLED] m
iH_BlinkingTexas Instruments %05100v3 USE Emulskor

S
A 4

v

TS
Ui

=0

[>] <[
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B=: BEYGARSEKEE”

o j:ﬁ” (COHHECtIOﬂ) 7( FF () TiResource Explorer 33 .

E/J i S )—[_‘ﬁ Y N N E[ — Packages: All D Devices: Topics: )
! ?EX’I %ﬁ%%ﬁ LI 7N

j‘ N : ’ Example Projects URL:bLep I &l UNPOILUIE EXANPIE DIOJECLTN0 LLS

N v — - :
P son G
= s Click on the link above to import the project. The imported project i
& ISTICK: Piccalo F28027 - 'k above {o import the project. The import '”
=% control : b the Project Explorer v roject n
-8 Example projects i

/\ lI:El %é = Wiew all 10+ example projects
%L_ i[‘% El/] fﬂb 2 1= Symmetric PWM Example

05 . . . -

B 2 P 1= Triggered ADC Example Step 2. & Build the imported project
"[/ EI [ ;R j-D =" Comparator Example

gBllnklng LED Example To chanae build option .
1= DC Motor GUI Example ‘gf 'ﬂ':fou'e‘y Of.; :

=% controlSTICK: Piccalo F28063 T
588 Eomnle nroacts select the Build toolb

ple proi menu item.

= View all 134 example projects
é} Symmetric PWM Example . X .
L= Triggered ADC Example Step 3¢ T Debugger Configuration

[

=" Comparator Example
'(b Blinking LED Example

[U_

£
L | o
BE Y |ao

v

| 1, e.'ecr r.'.e link above, or
- select the Project | Build Project

Texas Instruments XDS100v1 USB E

1= Sin FIR + FFT32 GUI Example P Click or

=% controlCARD: Experimenter's Kits this option is also

-8 Example projects

1= F2802+ Flashing LEDs Project Step 4: % Debug the imported Droie(:{j
é} F2803x Flashing LEDs Project
%% F2806x Flashing LEDs Project Click on the link above to launch a debug session for the Blinking LED
T F2833x Flashing LEDs Project Example pi q.'ecr and et,.rc.'. fo :.'.e CCS Debug Perspecnve
é} 2834 (DIM100) Flashing LED: Additional

124 C2834x (DIM168) Flashing LED:

=% Mator: High-+alkage Motor Control + PF
-8 Example projects
(= Open example projects folder D

<[ il ]| ] N . :]

Select the |

n, click on the
select one of the debug

i3 TEXAS
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B4 FRNIRLED I

° j:ﬁ E]\E:i % 4ﬁ R :‘@'ﬁ )—‘_If( EE‘“-I/JEEI —‘[/it TE‘.F LZ:I TI Resource Explarer &2

AJ¥)35 H ”(Debug the imported
project)f e K 1A H

o HBNTER— SRR
— e IRAFUE A
— Mg (M)
— JadhiHRAs (CCSHH

F]“CCSDebug™ &A1& )

— JERCCSE|Hbx
— MR EIHPR (NAE)
— BT R R

o AFEE ULl EIrE
fE? ] UL & e kit — 4820
B Gk

é} Triggered ADC Example
05

=" Comparator Example

é} Blinking LED Example
1= Sin FIR + FFT32 GUI Example P
=% contralCARD: Expetimenter's Kits

-8 Example projects
{143

=+ F2802x Flashing LEDs Project

14 F2803x Flashing LEDs Praject

14 F2806x Flashing LEDs Praject

é} F2833x Flashing LEDs Project

[

145 C2834x (DIM100) Flashing LED:
124 C2834x (DIM168) Flashing LED:
=% Mator: High-+alkage Motor Control + PF
-8 Example projects
(= Open example projects folder Q

s lal Devices: Topics: E
Packages [+ P )
Example Projects URL:
. Dlep 1L R PO e exdimpie project m \A.o
145 GPID Setup =
= " Q:s ) ink above to import the project. The imported project is
-9 cni\ntrDISTICK: Piccolo F28027 e Project Explorer view,
=% Example projects orfed source files. To mo
(= Migw all 10+ example projects on the source file within the project to open the source file editor.
é} Symmetric PWM Example
05 . . . -
1= Triggered ADC Example Step 2. & Build the imported project
=" Comparator Example
05 L
== Blinking LED' Example .
s Toc n the project and select Properties
1= DC Mator GUI Example from the context menu. To ect, select the link above, or
=% controlSTICK: Piccolo F28069 s R
pys - select the Build toolbar button, or select the Project | Build Project
=% Example projects menu item
= View all 134 example projects
05 .
= Symmetric PWM Example R . .
Step 3¢ T Debugger Configuration

Texas Instruments XDS100v1 USB Emulator
ink above to change the device connection. Additionally,
this aption is also available in the project properties.

@iﬁ% Debug the imoortem
/C]

Click on the link above to launch a debug session for the Blinking LED
yect and switch to the CCS Debug Perspective.
other methods fo start a project debug session.
) he Project Explorer view and click on the bug

To relaunch a previous debug session, click on the
eside ft g toolbar button and select one of the debug

1 the history.

toolbar butt

D||:|
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B4W: WR“HNIFLED”

File Edit View Search Project Tools Fun  Scripts  Window  Help

MU (a8 -BPRe- iai@-%- - 4 [#5 ccsDebug) € >

%5 Debug E:@] = O 09= variables 52 | 54 Expressions | 34 Registers L) =k € 5 K & i~ T E|
%% Ow 223 G & 8 7| Mame Type Yalue

= w BlinkingLED [Code Composer Studio - Device Debugaing]

E| uﬁ‘iﬁ Texas Instruments ¥D3100v1 USE Emulator)C28xx (Suspended)
main{) at BlinkingLED-Main,c:60 0x3F4181

= _args_main() 0x3F41BC (_args_main has only skeletal debug info)
;.ﬁ' Texas Instruments ¥DS100v1 USE Erulator)CLA_D (Disconnected @ Unknown)

Lacation

<&

s

s

s

A F
s m
s

s

A T
ok |
s

s

s

s

51

52 // Uzed for running BackGround in flash and the ISE in RAM

53 extern Uintle RamfuncslLoadStart, RamfuncsLoadEnd, RawmfuncsRuni3tart:
54

55

EFFE LR R T

57 // MAIN CODE - =g

58 /555555500

s

o

GE DeviceInit():
a7

68 // Only uzed if running from FLASH

69 // MNote that the wvariable FLAZIH iz defined by the compiler (-d FLASH)
TO0#ifdef FLASH

71/ Copy time critical code and Flash setup code to RLM

T /f The

/¢ Dewice Life support & GPIO Wy Settings

FamfuncsLloadicart, RamfuncsLloadEnd, and FamfuncsBREunitart @

0% [ Licensed

Writable

Smark Insert

6l 2
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» .
eclipse

Eclipseif&: BUE

« BXTARGH DA B KHIH R BN R

. %E%%%J:%’éﬁ)\ﬁccws“ﬂfﬁ@’ (*.WKS) (BRDZET/HES ERBIZNERE, HEFRRNER
HEERFF—1)

« BNEMERMET —ERR M RESRENTIRE (“CCS Edit”H T E T K, “CCS Debug”, HT
% H RS

(perspectives)

Y \» .
- ALIE
GG B el DB i LD et e mposer Studio. in.c - C OseYGHIL D! [ E)x]
File Edit View Mavigate Project Run Scripts  Window  Help File Edit Wiew Search Project Tools Run Scripts Window Help
o : B i A iE TG Eik EIY-RS R -9 ﬁccsmt
[ Project Explorer 52 = & ¥ T O (£ 11Resource Explarer [£] BlinkingLED-Main.c 53 %5 Debug 52 = O || 0= variables 5% |6 Expressions | ¥ Registers EN = %‘j =¥ =0
2 35 BinkinglED: B AT TR I AN IIIIAAAAIIIIAAIIIIIIINAIIITII s [ i S BT e B 8 T Mame Type Location
in B
® —
3 E'"T':S =1 = % BlinkingLED [Code Composer Studio - Device Debugaing]
Y Includes 52/} Used ?ﬂr running BackGround in flash and the ISR in RAM =) I]@ Texas Instruments X0S100v1 USB Emulator /C28x {(Suspended)
(= ~Docs 53 extern Uint1f Ramfuncsloaditart, RawfuncsloadEnd, RawfuncsRunStart; = P
E@’ FIZSEEX—FL“SH 54 _args_main{) 0x3F416C {_args_main has anly skeletal debug infa)
Blinkingl ED-DevIn_F2508x.c 55 & Texas Instruments XD5100v1 USE Emulakor/CLA_O (Disconnected : Unknown)
ElinkingLED-Main.c B L L e L)
|5 Fz808x_CodestartBranch.asm 57// MAIN CODE - starts here
[ 4 F2808_FLASH_BlinkingLED..CHD: T T L T T T T T T T I T (@ T Resourca Explorer | (&) BlinkingLED-Main.c. £3 =0
[ F2808x_GlobalvariableDefs.c 52 void main{veid) L EEEEE L E bt bl bttt it bi ot bttt ittt ittt ittt ittt lttttilttitlltttotittt
i I T T T R T Ty B
[ 4 F2808%_Headers_nonBIOS and 0 o 3
I FZ806x_RAM_BlinkingLED CMD 61
) - . "" = Py 52 // Used for running BackGround in flash and the ISR in RAI
=l macros.nl_initla 53 extern Uint16 RemfuncsloadStart, RamfuncsLoadEnd, RamfuncsRunStart;
[2) TM5320F26069.coxm [Active/Defack]| 63 // INITIALIZATION - General o4
o -
cel N mitns /b i . - BTN IR A AN IIIAAI I IIIIAIIIITIIIANAIIIIIAIIAIIINY
o eviceInit () ; evice Life suppor mux settings o /7 TATH CODE - starts here
. . A e e e L e e e e e L e e e T i )
68// Omly used if running from FLASE : . ;
S3void main (void)
69// Note that the veriskle FLASH iz defined by the compiler (-d FLASH) ol
7O #ifdef FLASH 61
71// Copy tiwe critical code and Flash setup code to RAM gy
72 // The RawfuncsloadStart, RawfuncsloadEnd, and RamfuncsRundtart DD Galvs  THITTALISATION - Gemeral
= | B 644/
) conscle 2 = O 2 problems & =0 65
COT Build Console [BlinkingLED] 0 errors, 1 warning, O others :i DeviceInit(); /4 Device Life support & GPID mux settings
B = B~ %+ Desoription Resolrce Fath
¢ |G| el B UD '?N A ¢2// Only used if running from FLASH
& arnings (1 item]
i\ TTVCCSVS . 1) cosvEh urs 1\ bint gmake —x all £9// Note that the variable FLASH 13 defined by the compiler (-d FLASH)
gmake: Nothing to he done for “all'. 70 fifdef FLASH
U 71// Copy tiwe critical code and Flash setup code to RN
sers Build Finiched +5re 72// The Rawfuncsleaditart, RamfuncsloadEnd, and RamfuncsRunstart [
I N Fll=] I ) [5]

n® : Licensed i B : 0% @ Licensed Writabls Smart Insert | 60 2
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B R

o AL TR
—  HbrAC E s H
— R

% Debug &2 e ] @ 2@ 3@ g & e~ 50

= ¢ BlinkingLED [Code Composer’Studio - Device Debugging]

=18 Texas Instruments ¥05100v1 USE EmulatorC28:xx (Suspended)

= maini) at BlingdngLED-Main. 60 0x3F4151

= _maidl) 0x3F41BC (_args_main has only skelekal debog infa)

ments ¥DS100w1 USE Emulator/CLA_D (Disconnected @ Unknown)

o FkastT, 2R, Zbish, HAMASMED, BAICPU, HFHIIF
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Blink LD2

.« WBATIRABITRE »
controlSTICK i LD2BRZE N % [N 4%

) tmummuuuu

)'
»

%
\ .
A
.

*

a
D
b |
,
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U122 5 (watch points) ‘55?1

AR

fif 452 1\ 45 “(halt\suspend) 340 i 452 1F H kg 47

T WL
— PR - > s (View -> Breakpoints)

4

S Breakpoints 1 @~ W,

Gt —ANHT R W52 5 (Hardware Watchpoint), Conditin Breskpon:

Count Event

Data Access Counk

EA%@%‘EE‘XJD%‘\ N #iﬁfﬁﬁ“%'fﬁ” Hardware Breakpoint
— /7. % (Location): GpioDataRegs.GPBTOGGLE.bit.GP1034. raym——

— W1E(Memory): Write

["‘ hWandwanEsa I o 31

Location: | GpioDataReqs. GPETOGEELE, bit, GPIOZ4

I %[ Cancel

Mernory: | Write

(=)= Yariables E‘:’F‘:E><|:|r|E!ssi|:|ns 1181 Registers | ®a Breakpoints &2 & - 3& &, + = Q:{; = =0
Tdentity Mame Condition Count Ackion
&’ﬁ' #uapioDataRegs, GPETOGGELE, bit, GPIOS4 (0x06FCE)  Wakchpoint Remain Halked
i3 TEXAS
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W AW S (watch points)

o FHWEITHIR. Rt LD2YIHIN AT S B Bl 1k
(GpioDataRegs.GPBTOGGLE.bit.GP10345 A\ #:4E)

e 005 Uaig - il dug L EE s e e = Sud2 Sagpusar Studiu

AER

File Edit View Search Project Tools Run  Scripts  Window  Help

5

_args ma|n() Dx3F41EC (_args_main has only skeletal debug info)
x@ Texas Instruments XDS100w1 USE EmulatorfCLA_0 {Disconnected @ Unknown)

IE:J TI Resource Explorer @ BlinkingLED-Main.c &7

Lr.iil, S LLSUILE WFLUMIGAL LEQLL LUE LULCLL WP DU

for(;;) //infinite loop
{
if (CpuTimerORegs. TCR.bit . TIF == 1)
{
CpuTimerORegs . TCR.Bit.TIF = 1; // clear flag

//Toggle GRIOS4 (LDZ)

: 4 B E@-BE e~ a0 (K- P ¥ |15 CCs Debug | [ cos Edic
%5 Debug 22 [ e R S 4 V& ) @q? = B || t9= Variables | G Expressions | 44} Registers | ® Ersakpoints % & - % & e w = <‘===;>
=1 ] BlinkingLED [Code Composer Studio - Device Debugging] Identity lame Condition Count Action

=0 Texas Instruments ¥D5100v1 USB Emulatar/C28xx (Suspended) ¥ % aGpioDataRegs. GPETOGELE, bit, GPIO34 (Dx06FCE) Watchpoint Remain Halted

v o H
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B B

o BH P IR
« LB CPUKSIK i (2B

o WO N R LR E AN R4 T 3
© — P IR DGR — AR E AL (BURCCS3.3 7 (1 E)iimi (animate) )

W

EEHIERE M CBE S TS Lh/Vk R R

SCAEPIN O (CCS3.3IMERM A (probe points))
IBATGELE AR

WCE L R

4 CPUER ER (trace) (ZEAN I FIARMAIDSPZS A1)

()= Yariables | & Expressions | 08 Registers | @ Breakpoints 3 & - ] o=l m | @ E iff:, ¥ =0
Identity rame ondition Zount Ackion
ﬁ main.c, line 37 (C$0WELEr Breakpoink ooy Femain Halked
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LIEA: NN

o AT AR AL Gt R B (View) S R FT T
— PNAEM Y 25 (Memory Browser)
— i1 %% (Registers)
— [ %% (Disassembly) (3 K1)

o WEMN
— W YEACRD AT AT B R T
—  JH“Wr 25 (Breakpoints) #i K Sk A F W A4 %
— VF 28x [ S SRR AR A KT A
o WRZR pS A — AN b AR KT R YR

1ETS.
oIt

-

e Lol RN R Sl e TP d Ol
| Filz _Ed Search Run Project  Tools
. L Project Explorer q
EE Outline -
ﬁ Debug (%1 Problems e
= ¢ Hl Wice
iy El console )

% Debug
7 Target Configurations Faac

L:'l Memory Browser
P S8 Registers
() TIRes "' ™58
o Expressions
25 1ind

26 ()= Yariables
o T LA <R (Debug) ¥ B g AR HEA T LR B 4F 27" e s .
- E%ﬁﬁiﬂ$ﬁ}? o Other, ..
— PR
— gL
i3 Texas
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. 5.
o (EHBBEAZ PR A main” 2 RIS Bl e 2] main” 75 [ 1

il
o« PJH BoRUEACAL (Show Source) 4 £l

S RO G b B YA AT 4

== Disassembly &3 main 1 D 2 | 2 0~ — O
main: D
3f4131: FEQOZ LDDE 3P, HZ
E> G Devicelniti(): A4 Deviece Life support & GPIO mux Settings %‘
3f4182: TeVF4000 LCR DevicelInit B
E> T HemCopy [ &Ramfuncsload3tart, &RamfuncsLoadEnd, &£RamfuncsBEundt
3f4154: SFO0s000 MOVL ELR4, #Ox0ODS000
3fdl186: SFYF4207 MOVL ERRS, HOx3IL£4207
3fd4188: L34qz2 MOoVL *-SP[2], EXLR4
3f£f4189; SF3F41EC MoOVL ZaR4, HOx3Ifdlec
3f418h: TEFF4128 LCR MemZopy
E> = InitFlashi): A4 Call the flash wrapper init function
3f4154d: Ted0s000 LCR InitFlash
E> a3 CpuTimerORegs.PRD.all = wSecs500:; S B00Om= + 2 (# of LED =t
3f415L: Te1F0030 Mo DF, #0x30 D
&l I I B
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VF22 WD REATR AT DUIE L A ks e IR 128

PR “CCS Debug” #EML A -
— T H - >R - >0 A 1 Y #8 1E (¢ Tools->Debugger Options->Generic Debugger
Options)

e B AR T, il an 5 2R

— HIEATR E R

— HBhIER R H by

— SEREI (FREAEAE SRR 414nC2000)
— NIRRT A

farangaray
ST T e was

T acAE TR 1 (Remember My Settings ) IE R ORAF a8, 7 AR kAl
H
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iR

_ ll*t:

o VERE T HT I
— (ERZ A LA, Al o 20 )
— £l L,

« BRI S

2B BB (Profile Clock)

(SCIDI 7 W R

— 1247 - > - >3 H (Run -> Clock -> Enable)

— IR BRI B

&) 0 Weritahle Smart Insert

26:1 j

o AN “GpioDataRegs. GPBTOGGLE.bit.GPIO34” 5 A )W %%

Jei 1

o Ridtis ATk

IBAT 2 A

{¥) ; 39,990,094

— RN Z T 7R ~40MA 1

IDOIT

ROZ

i

TEXAS
INSTRUMENTS




B INLD2 A $F 3 &

o LED L2 AR 2 n] il

1o AR S IR B ME R SR

1& 24 BlinkingLED- MAIN.C831T
CpuTimerORegs.PRD.all= mSec500;/ /500 #0* 2 (LEDARZS # ) =1FPINHRIHE R
— #|: CpuTimerORegs.PRD.all= mSec100;/ /100Z#)* 2 (LEDJRZ: # ) =200=240 [ [N HRid %

IRATSCAF

T

IE:J TI Resource Explorer

=

=1

g3
g4/
857/
g6
g7

[£] BlinkingLED-Main.c 52 | [T | c_int00f) at Dx3f413d

77/ This function must reside in RAM

InitFlashi): A Call the flash wrapper init function

79 #endif // (FLLZH)

CpuTimerORegs.PRD.all
CpuTimerlRegs.PRD.all
CpuTimer2Regs.PRD.all

817/ Initiali=se Period of Cpu
g2 /¢ Timer period definitions

Timers

found in PeripheralHeaderIncludes.h

mSecli0; A4 100m= * 2 (# of LED states) = 2
maec1000;

w3ec5000;
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NSE

«CCSHR B T AR (K148 4k 7 s

A3 s

> V) 51 () CCS L 4 135 LK
> 1 Gt a4 B T — A S, EREIAIBA - > B ORAH 1) ) 52> (Team -> Show Local History)
ST DAHE 2 T (R Y SO AR ART LA A RRAS A LU sl [ 21 LA 1T 0 AR

> EGm AR B NSRS

HATIF

> A B B SRR R AT i RRCAS 12E A 7% B

@TI Resource Explorer [£] BlinkingLED-Main.c [©] c_intoog) at 0x3f413d éD Compare BlinkingLED-m... &3 | = 8 |'§_|1 History 3 =0
EBlinkingLED-Main.c
@ C Compare -
o B = | B &
[ maf 8
=] @ Translation Unit 5
® main Revision Time
= 11/18/11 3:56 PM
H 12/20{10 5:47 FM
[£] € compare viewer (@] <5 | £ 4 42 B
Lacal: BlinkingLED-Main.c Local histary: BlinkingLED-Main.c Dec 20, 2010 5:47:25 PM
|| CpuTimerORegs. PRI . all = mSecl00; |—| CpuTimerORegs.PRD.all = mSecElD
/4 CpuTimeriRegs.PRD.&ll = mSec1000 // CpuTimerlRegs.PRD.all = m3ecl
J4 CpuTimerZRegs.PRD.all = m3sc5000/ // CpuTimerZRegs.PRED.all = m3ech
I I
/¢ INTERRUPT INITIALISATION (not neeq /f INTERRUPT INITIALISATION (not
I (hest to run this section after of £ (best to run this section aftg
A L
/¢ Enable Peripheral, global Ints and /f Enable Peripheral, global Ints -
/4 IER |= M_INT3: /¢ IER |= M_INT3: =
/¢ EINT: /¢ Enable Global interrupt /f  EINT; // Enable Global inter
/¢ ERTH: // Ensble Global realtime /¢ ERTH; // Enable Global realy
=] I 1] <] i 1] a 2] I B

*CCSIA R H [y s

> VST v ) SCA:
> BRI, AR B P B AL S Pk K (Recover from Local History)

|'§|_] Hiskory &7 =g
BlinkingLED-Main. c
& 5 B = g
Revision Time

= 11/18/11 3:56 PM

= 12/20/10 5:47 P

Open

Open With »
ith Local

Compare Current w

iaet Contents
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EHEI

i

o PIHRI<CCSHTRIR BRI
o TEEINH

— T H - >#yE I H (Project -> Build Project)

File Edit “iew Search

i A | B

r -
a L

ﬁ* Cebug &3

= '« BlinkingLED [Code
= .Jj"‘:-‘ Texas Insktrunm

e

° CCSé‘\ g ijj*\/_\j?lj\m a ﬁﬁIEY:E-E’J;I]iﬁ E@%%F%%? EA f rnain() at E
20 AR TR, D ) 7 T R 3L e

1

— WG Yes’, CCSK I HT N/ FIET,

HiE4T B LR AL

1S,
oIt

= PR [ a a - a o a e e
S e OO Haiig = Blbag gL ER e D L= G e = e Sy

Tools Rum  Scripks Window  He

ZZ5 Example Projects L
L
= Build &l Crite |~

Build Working Set % k

Clean... ends
Build Automatically

3l de
Properties nne

*
L

-

ww M 5 OErd T AliGa
RETOa M TE RO PR O a Gl 1

DA file that wou are debugging (ElinkingLED. out) has been modified.

-

Do o wank to reload this File?

[ remember my decision

%]

es %[ Mo
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Blink LD2

o BT HAIBITIE ®
controlSTICK - [ L D23 AE W 12 DA B R 1) 38 B2 1 PR

N H 11 )/ ! m, 20 . w ——
* m“ ‘ ~
mmu?n tmumumuuu : :A . |
A
-

™,
L)

*
a
>
L |

DOIT
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FEURE (BRSBTS - H2E4 o

SRR
MR A 1P PR T 240

J2 F7E'GpioDataRegs.GPBTOGGLE.bit. GP1034" [ Wi % i
— WEE AR T N B AL

N S e /< |

— IR N 1% s —8ME 3] (4A0MIIL /5 )

0% & Licensed (D) 27,844,068
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# ) F R AE i

o HEAZHEALE
o Rl
o XIHAE M A, IR [P 2 CCSYm 7 A 1
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D | X lfm ‘
MBNE LRSS ooir’
o MPFEF LML CCSEe ), IR HARRE H Ar L INAE B IA A

, PRA] PABC B CCS Hongdn H &7 5 2R34T 13
o R FLEI S B NS, AR EIER A E ..

» Eclipseft®r: HACE- =30 H 2 H ARECE 5K E sk < il 5 B
A AR B . AN B UFERZE TR H bR E, il E...

., .
eclipse
S S S i M  a S et P

File Edit Wiew Mavigate Project Run Scripts  Window t

: [~ R - g E
[{"5 Project Explorer &3 s 1 BlinkinglED t
= 7= BlinkingLED [Active Debug As »

+ 91:,3 Binaries
- [mjl! Includes Organize Favorites. .. %
R p T =TT -
i3 Texas
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)

4

MENF ERE

A

=

=]

FE 22 AR % B #5228 “BlinkingLED”;
— FE“INIETN(Loading options) ', #EFE“ HUINZ AT 5 (Load symbols only)

=

Create, manage, and run configurations

5 —*l
TE X B3 Mame: | BlinkingLED

A TR R A FERR 2

e M Target 'E;y Source | =] Common

E C,I'C++ Remote Application
e v PG tudio - Device

Project | BlinkingLED

Program | $4{build_artifact:BlinkingLED}

Loading options

) Load program

(2} Load symbals onky |

2

o RJRIEFENHIT, ARJE U

Device | Texas Instruments ¥DS100v1 IJSE Erulator/C28xx

“Program”

UOIT»’

i3 TEXAS
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RN L MRS =
PR B, SRR AR, RS R IURIT GRATRE H AR
BORE PP ()

o FEFTHEES (program counter)Bi4i e B AEACIS N 1 5, AN &4 £ R AL
— “Ia17 - >izfT 2 E R (Run->Go Main)

-
s e OO LS = Sunye s gat fungppeds = Sl Sypnagy Gegedi

File Edit “iew Search Project Taoals |20 Scripks Window  Help

- |E| G ¥ | v & Connect Target Chtl4+ale4C
— Disconnect Target Chrl+Al+D
%5 Debug 2 (= |
= &% BlinkingLED [Code Composer Studio ¥ Load (N
= m"@‘ Texas Instrurnents XD5100w1 L
= 0w3FFPSC (no symbols are LPPResume F&
x@ Texas Instruments XDS100v1 LI
Terminate Ckrl+F2

i O b [! 1
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MEBAF_EREFAS

e

- 5]

File Edit “iew Search Project Tools Run Scripts  Window  Help
-HE i (Ee@- RO e- aifl-3-1 8- ¢ %, CC5 Debug | (5 CCS Ed
%5 Debug 5:3] e [ 2ok S |ea” =0 ||W= variables | G Expressions | 1} Registers | ®a Breakpaints 5:3] & - KB E s & ¥ =0
= % BlinkingLED [Code Composer Studia - Device Debugging] Identity Namme Condition Count | Action
=g Texas Instruments XD5100v 1 LSE Emulator/C28xx (Suspended) [#]* aepiaDataRegs. GPETOGGLE bit GPIO34 (Ox0GFCE) Watchpoink Remain Halted
= _args_main{) 0x3F41BA (_args_main has on
)ﬁ’ Texas Instruments X0S5100w1 USE EmulatorfCLA
() T1 Resource Explorer [ €] BlinkingLED-Main.c &2 | [T ] 0x3FF75c = O | 22 Disassembly E@l |E|'lt3" locakion here 2] e i e R =
L L e T E L L L L LT E T | main: ]
E7// MAIN CODE - starts here P af41E1: FEOZ ADDE 3P, #HZ
e L E L L e L E E L L L E LR 56 LeviceInit(): 4/ Device Life support & GPIO mux SEH
5% rvoid main (void) Ff4152: Te7F4000 LCR Devicelnit
60§ 74 MemCopy { eRamfuncsLoad3tart, &RamfuncsLoadEnd, &Ramfu
61 3f4154: SFO0s000 MCVL XAR4, #0x00S000
62 f/======== Ffd415e: SF7F4:=205 MCVL XLRS, #Ox3£4205
B3 54 INITIL 3£f4185: L34z MCoVL *-5P[2], HALR4
64 f/======== 3f41589: SF3F41EL MCVL HXAR4, #0x3fdles
65 3£418b: 767F4128 LCR MemCopy
{1 DeviceIniti(): 44 Dewvice Life support & GPIO mux settin L] InitFlashi): fFf Call the flash wrapper init funect
67 3f415d: 7E408000 LCR InitFlash
65 // Only used if running from FLASH 53 CpuTimerORegs.PRD.all = m3eclOO; £ 100ms * 2 (% o
69 /4 MNote that the variasble FLASH iz defined by the compiler | Af418f: 761F0030 Mo DPF, #Ox30
70 #ifdef FLALZH 3f4191: FF2O3D09 Mo ACC, HOx3d09 << 9
71/ Copy time critical code and Flash setup code to RAM 3f4193: 1E0Z MoV L Foxz, ACC
72 // The PRawfuncsLosdStart, RawfuncsLoadEnd, and Ra.mfuncsRunS@| ime SF (M Tir=r D TED i+ TTF == 1} @'
3 | (] I [¥]
ECDnsoIeEﬁ@l &G ARl =t B~-5- 708
DT Build Consale [ElinkingLED]
- ) [~]
CiWTINVCCEwE . 1hceavEiyutilsibin' gmake -k all
cinske: Nothing to ke done for “all'.
#%%% Build Finished ##+%% [+
: 0¥ [ Licensed
1P TEXAS
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B i R % T (build options)

o &LRSIE

 “BlinkingLED ¥t H b A, JRikFeE e

bype filber text

Resource

W& C2000 Compiler

- Basic Cpkions

- Assembler Options

- Command Files

- Default File Extensions

- Diagnostic Options

- Directary Specifier

- Entry/Exit Hook Options

- Feedback Options

- File Type Specifier

- Include Cptions

- Language Options

- Library Function Assumptions
- Optimizations

‘arser Preprocessing Cptions
- Predefined Symbals

- Runtime Model Options
P C2000 Linker

- Debug

General

(=1 -

Configuration: |F2806><_FLASH [ Active ]

[Manage Configurations. ..

= Main

Qutput bype: | Execubable

Dievice
Farily: 2000
Wariant: | <select or bype filker bext> |TM5320F28069

Connection: |Te><as Instruments “DS100v1 USE Emulator {applies to whole project)

w Advanced settings

Device endianness:

Compiler version: |TI v5.2.2

[ Mare... ]

Effective compiler version: | TIw6.0.2

Output Format: leqgacy COFF

Linker command file:

| F2806x_FLASH_BinkingLED. CMD

[ Browse... ]

Runtime support library: | rs2300_ml. lib

[ Browse... ]

Restore Defaults Apply

® Show advanced settings

i OK i[ Cancel ]

i3 TEXAS
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BB SO R R T

o REERJELIEIIN N — AN E2 dE (build configuration)
— IR BCE O “F2806x RAM”
Configuration: | F2806x_RAM [ Active ] | Manage Configuratians. . |
o HLALIRE
— FLAE T (Basic Option)4i
— H g nh 3.
— A F DA RS R /N> (Optimize for code S|ze)

Basic Options

Configuration: |F2806x_RAM [ Active ] [Manage Configurations. ..

Processor version {--silicon_wversion, -v) |28

Debugging model Full symbalic debug {--symdebug: dwarf, -g)
Optimization level (--opt_level, -0} 3

Optimize For code size {--opt_for_space, -ms)

. St sE

QOIT

i

TEXAS
INSTRUMENTS




R T B

o BB B AN “F2806X_RAM!
— AR H
— EPERIERCE - > B 0T - > F2806x_RAM (Build Configurations -> Set Active
> F2806x_RAM)

o iRt (build)dzHl
~ EEHEMEF, BSEFF2806x RAM HLE Ak

o Rbn] DL U FCE AN i i M AR S T sk, AR e I
PRAS T &
— EFEF2806x RAM”, ‘BE=HiF2806x RAML &
— WOEBCE H 2 kbRl R
S S

1 F2a06x_FLASH
M
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Y AT LA

o BRI H AT S E A g e A
— SEPp LIXREAEREANECE S0 LR BCE
— e IR AT ME ] — AN A, ReAThics s —4>

o WRARAEME ] — A8 FEI S B ds IR 2RSSR IR I H P45 72 1) 2
e IR

o CCSHf VPR FEA M HAL L REFR B I B A G i 4

o URSTEA BRSO DB RIS Ry, CCSex H ARG 1250 124
b il
— BRI, ARt AT PLAEYRCCS—ANRRAR ) G 195 75 1) 1l
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b U 1 B PR B A i3

FERE R I H AT Ik <& 1 (Properties)

ik ik & “(General)

p T G PR A R RRAR T 5.2.275% 121 1) 5 22 (More) #441.
U el NN S i iy R R P N T o B i

CCSKsk Bt 12 M gwieds, JHEBIEF R HWIE. BFD, IAERE %
PR 2T 5.2.2

(ARSI ENIIRTE

]
- C : 4 r
s o Jalden Cupulley Vs \3

Flease select the compiler version, Alternatwely browse to a build-kool location in the file-system, That tool wil
automatically be registered for Fuk

154 Family: | C2000

Compiler

() Select compiler version:
(%) select new build-tool From file-system: | C:\TI4C2000 5.2,2 Compilsr

oK H Cancel ]

i3 TEXAS
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H ArBC B
TARGET CONFIGURATION




PRECE A - FERRAR

o HFrHCE SR 8 X4 5EEIXMLYC (U E44 *. CCXML)
“’U — 25T CCS3.xMHL & X (*. CCS)

 “H¥rAC & (Target Configurations)” A1 & F & #E A 4E4 H ARIC & SR
o« HbRHCE 5 2% (Target configuration editor) T~ A& /M& 2 H Frlic & S0
o JEAR(Basic)ikIil- KA K2 EH i H

« 2 (Advanced)iBI RN T BN RYE, Wt , sE g
M /BE 6 FE) H s e
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Al HAT A B {1

o FIJFH prlc A (Target Configuration) i) 41 ]
— WLE- >HFrBCE (View -> Target Configurations)

o« A AHHIECE

Target Configuration

Target Configurations E:El @x -::;.(h N EWAl aNEELCON I EOTELIO EE
R -

| kvpe Filker kexk

Create a new Target Configuration file,

= Praojects

File name: | F28069_conkrolSTICK, coxml

Use shared location

Location: | Ci/Documents and Settingsfal389327 fuser/CCSTargetConfigurations| | File Svstem... | Workspace, .,
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e 4

Al HirEC E

¢ Yj_i ZIK”*TLL’ jﬁj:%iﬂﬁ'

— J%E$Z(Connection): Texas Instruments XDS100v1 USB Emulator
— & (Device): controlSTICK - Piccolo F28069

T F2E069_conkrolSTICK, coxml &4
Basic

General Setup

This section describes the general configuration about the target

Connection @struments ¥DE100v1 USE Er@

Board or Device | 2gngo

] eRiccaly F25069
[v] u:u:untru:uISTICK PIECD|D F28053

Piccolo F23069 conkrol3TICK

Moke: Support For more devices may be available From the update manager

Basic | Advanced | Source

Advanced Setup

Target Confiquration: lisks the configuration options For the target

Save Configuration

<

. ([ eetiate(save) it
| 7 F bR B A

To test a connection, all changes must have been saved, the

Test Connection

£
configuration file contains no errors and the connection tvpe supports this
Function,

Tesk Connection

IR (Test
Connection)#%

HH, LAk H PR
B
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WEE - /&

Test Connection

To test a connection, all changes musk have been saved, the
configuration file conkains no errors and the connection bype supports this
Funckion,

Test Connection = "
s oo Qe

The JTAG IR Integrity scan-test has succeeded.

Thiz test will use blocks of 512 32-bit words.
Thiz test will ke applied just once.

Do a test using OXFFFFFFFF. “?)”Uﬁﬁi.j%”#%ﬂ, )I%ﬁi‘_‘ﬁ
3oan tests: 1, skipped: 0, failed: 0 /f _Aﬂ:[ﬁ %ﬁ?ﬁ@]ﬁﬁﬁﬁ‘@ﬂﬁ

Do a test using O0x00000000,
Soan tests: 2, skipped: 0, failed: 0 jt{q:

Do a test using OxFEO3IEOE:Z.

Soan tests: 3, skipped: 0, failed: 0

Do a test using OxO01FC1F1D.

Soan tests: 4, skipped: 0, failed: 0

Do a test using OxS5L533CCAL,

Soan tests: LS, skipped: 0, failed: 0

Do a test using OxARLCCIZEL.

Soan tests: b6, skipped: 0, failed: 0

4111 of the walues were scanhed correctly.

<:::E£§ JTAG DR Integrity scan-test has succeedgﬁ:::>

[End] I
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WEE - /&

o QRIS AR IR rh P AN RIS BB AS H bR, IEEH =g &
(Advanced Setup)
— MR ('Connections) #1) 38 HH I FEE E (1) 2R 1Y
— R MNA PR EFERR e AL (B (Devices)”, “AbPER(CPUs)”, “i%
Hi#%(Routers)”) ¥ N £1li% 2

o MR A, AT LA AN B A EA A H AR AC &
» A AR )R SR R S G A I B R A IR AEDC H A B R

A
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WEE - /&

o HEEH bRECE BRI B
— feEvIimntb et (GELRA S
— F55E IcePick T~ 45 i) v 1 =
— %47 (bypass)CPU
— WEITAG TCLKAi %
ATawATaN
~3 T

@ K{LICCS3.x CCS¥EE 1. A

%) F28069_contralSTICK coxml &3

Target Configuration

All Connections

= T, Texas Instruments X0S100v1 USE Emulator_0

= B controlSTICK - Ficcolo FZ&5069_0
=48 TMS320F 26069 Mewr...

Gt ce o

Test Connection

Basic |Adwvanced | Source

Cpu Properties
CPU
Set the properties of the selected cpu,

|:| Bypass

initialization script

LA demulationtgel\F28069, gel

[(slave Processar
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8 3<% (Debug Session) "5,’,'%

o HBERLPFT R H ARG E SO, JRIE SRR Bk € AU & (Launch
Selected Configuration)/d 2l A & 16

7| Target Configurations &3 (& b ':,-';-(h = -0
[#] F28035_xds100.coxml [~
[T] FZB035_XD5510U5E. coxml

59_conbralSTICK.

) F2808_xds100.coxml [#] Mew Target Configuration

[#| FzE05_XDS510USE.con %6 Delete Delete
7| F2312_sdS10usb, coxml Rename Fz

[®| M3IP430F2013, coxml é‘ﬁ- Refresh F5

%) MSP430F2274,coxml :
[®] MIP430G2231.coxml E Launch Selected Configuration
7| omapl137 _xds100vz2.co
7| amapl138_bhSa0mm, coxr
[T omapl138_sd510usb.co
[T omapll38_xds100w2.cc Properties Alt+Enter
[T omapll38_xds5a0vE  coxml

|7/ panda_xdsS60m.coxml

Set as Defaulk
Link. File To Project L

[ <]

Click the Mew buttan to create a new target configuration File, Click here ko hide this message.

i3 TEXAS
INSTRUMENTS




P E:HirRE

CJC++ Prajects | |7, b =0

o BEPTLUEAR LTI, SHIER HASBCE C X |
XM Li/ftl: ) bvpe filber bext

=== Projects

R AR AIE. A B ARRE, O o

T, MSP430F2013.coxml

P 3 5%k 52 P K & (Launch Selected 5 S hellworld
Configuration)” %) OMAPL13&. coxml

=== User Defined
T/ 28035_x¥05100.coxml
o “JABNTIHA 23 (Launch T1 Debugger)’ ¥ {i 28t signum,coxni
@ﬂ%%‘j‘u lzgl E“ ’ [Defau It] ( %ﬁ% ) jﬁlﬁ‘}z‘ EI:‘ jﬁ% B962-bh.coxml
H */_ﬁ@a%n: a962-zd, coxml
— A R SO I R e B N BRI (Set as Default)”
, AE R BN H FRilic B
— AR I H $5 € B H Al B SO, e I E
(Debug Active Project)” i FH BRI H ArHC &

T R

Ankares BH Mew Target Configuration

Ankares_3C ¥ Delete
ies_BH.co Renarne

Set as Default
Link. File ko Project

cedl6_be s
6416 _dsk_
cetl6_le_si Properties. .
cb4xp_le_sim.ccaml [Defaulk]
c6711_dsk_bhSa0lan, coxml
CATSEENM_XDS100, ool

deeram LodoaAm ool

A A e A A e A A A A A
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PVE: GELX £

9

S 2T T R BT A N A R GEL SCA A H: =4 i (R 2

° ﬂﬁ’]ﬁ H‘]T}’E{‘%’ﬁz' T GEL Files 57 =g
— {EgwAE T A GEL Files (TMS320C28XX) (3)
— Wl CHOINED St eI = Stotus
— MIBR/ENACL ooy ot || LR Cpm - psemberigfeme s
- ﬂﬂ” sz%/ ﬁcﬂ ?—F%Fﬁ ﬁ Iﬁ: 2:22:2 Al :
RN GEL S oo =
o BrnE R GEL A AEAL I v L 3R
o WERMEGAEA A, IRERE W7 1)
i3 Texas
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CPU g i 2% yu.
CPU TIMER EXAMPLE




CPUENASGH: FRIJME
« FEHFFR
— LT CPUE 28 1417, Bl ASH i ] #4000 H
— TR
— Ja s 1 AN 2R P 2l control STICK |
— IBATIE
— ) FH S I AR R 52 A% R 114 S s B
o T HFME

— AR AT H

— HERRIBEYR

— BERI BT AR AR
— WA R

— SR
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AR —ANF R A B HE I

« EEHR
— NIUH G TAEX A
— B H
— AR S SO R 2T H
— AR B B A R
— TR H A, IEAE A TR IR

b))
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FFIH
SHARING PROJECTS




i

0

™

R R E I B YRR SO AT H SO )
O B CPE (linked file) 930 H AR AT AP (I H AT B SCAD

S I H (A
- R/\¥Iﬁ HxHye (i H gk A B&F g i)
— {30 H “n] #2EH (portable)

o VH BRI H H 40 i A

«Hﬂ
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FEIH - R

» EHEB: HEDZE—BUE IR T B IZI H K FTa IR
P BT SCAFAAE TR E SCAR A

o WA RIH L R RIR A S -
— A LR B ANB ) A AT RS T H B SR 45 25 RS
— g2 H W P el LS Nz H 204 TAEX : A<l - >3 A
A I)ICCE [ CCSHi H(Project -> Import Existing CCE/CCS Project),
T e PR 21 iR I H Sk
— EHTRSRNIH, B s H R SRR H S
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FEMA - FHSEARImE (1)

- RIS FESZE—ATHEARAFEWETE BREXH. —8 (8
£HR) T H HIPR SO R BB PR R B

« {fHJCCSS i1 H (Export Project), PAGIEE—ADNIHRSCH: (zip) o 1ZSCHFALE 0
H 11 32 DL B It H A A ) Pl A
— VERG, WRINH A s M 4248 & (Linked Path variables)[f)i%, Xk
S !

o FHEWINE: e ENL FERS I E
— X ->S i (File -> Export)
— JEFFr B (General)”, SR JEIEFE VAR SC 14 (Archive File)”. s F—
(Next)”
— R R TR MRS SV IS I A T BNEFS IR

— YIEE NI EE, Al BEES S BRI T A S DA, S EIE
5510 1 R I HE R F5 7~ Ay B H EHiz I H

— B ARSI A FR, JFIEFZIPELTAR, KRG midi“se i

— CCSEERE MV ENL LA — A& I H M ziphtar SCF. 88 THH Hx
ch PR SO R R | R T A s

N
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/\glﬁ - ﬁ

it

Bt

L |

I

(2)

o i —6dlEs ERATH: e WEFS S ATUH -0 H S A2 TAEX
« IiH - >3 AIA ICCS/ CCEEClipsei H

— Project -> Import Existing CCS/CCE Eclipse Project

— 0 DSCAE TR 1) PP 2 B 208 -1 VRS S P (Select archive file)”
— D D0 IR PR AR A VAR ST A
— ERAH AR ORI H . BUAEDL Pt 4ik, RBmE AR

it H
. ){_:_(EE‘“%}:&”

— JUH 45 AN H AR R AR X
o BERGI TR BEIEORE 2 AVAAS R DL RS IEOR A vt SO0 L L R i A

13 TEXAS
INSTRUMENTS




L |

/\%Iﬁ - ﬁ S %

‘ﬁ%&%:
- XE—ATH XK. THKZRRACER T AR AR E A
— TR BRI H SRR AT BIRARS A ] TR

o RZHAPI VT ZILZIH ,  MAEHH I P PSP
— M A ISR R AS i A

o T AT H PR REAL, BABR R IZIN H GRS 1 A =
o RIRSARLIN H WA Z5RE e AT 400 P4

o AR AT ASAR I H 2 AUREAEAME SUEART I H SCPFI TR O T e A H]
— OGS AR YA At 2 ) T HL R 130 H o PR AR %

B CHRWE (3)
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CPUE T2

i < #rICCSTi H(New CCS Project)
]
— AECRRII (Welcome) T T 1 << 5 i 1 H
”’(New Project)

i BB A
SR S

A2 BSGH)IH K S AR T B B s
(Project Explorer) ¥ &

I A A R <“maiin.e A

ﬁﬂﬁ%—/l\%ﬂﬁ

""J| LSS D B

1
UOIT
J_J\Zﬂ

CCS Project

Create a new CCS Project,

Froject nam

Cwtput tvpe: | Executable

Use default location

Device

Family:
2806 Piccolo contralSTICK - Piccalo F2E069 >

Connecti0n< Texas Instruments ¥DS100v1 USE Emulator >

b Advanced settings

Wariant:

w Project templates and examples

Creates an empty project fully initialized For
the selected device,
=| Empty Projects
=
+r Emply Assembly-only Projeck |
= Empty RTSC Project
—| Basic Examples I

= Hello World I

+-||=| DSP/EIOS w5, xx Examples
+-|=| IPC and 1) Examples
+-[1=] qwsirinsg

'@:‘ [ Finish [ Cancel
%
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CPUEIE: QIR M HEERERRETR i3

° *Tﬁiﬁ/ﬁlzﬁﬁﬁﬁlﬁ e afareTtes = [E]x]|

(P rEfe ren CeS) @ Linked Resources -

= General
Enable linked resources

= N —I- Editors
/Ifz\l l:l -> é:@lﬁ = Text Editars Drag and drop items on a Folder or project
N
Linked Mode @ Prompt ) Copy  OrLink ) Link and create virtual Folders
= \Workspace iy o
i Linked R. Drag and drop items an a wirkual falder
° W”‘]dOW -> Preferences inked Resources

(# Prompt ) Link ) Link and create virtual folders

ﬂ Y SE VR B 9 =
° j:T “'%\%j:% {ﬁ[\\ Y R (L N ked Path wariables specify locations in the file system. The locations of linked resources

may be specified relative to these path variables,

RESOU rCe) éj‘ilﬁ Defined path variables:

Mare Szl e,

« {E BB A "Linked”, LA e citeriane >
ik

o EFHR " (New) LHDREIE | 5 & [ o
— AN FERE P YR A B (Linked L
Resource Variable), 351

controlSUITEAR H =k A &
o SRR, Rid€OK”
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CPUER2%: AlE

- fEid

E— A HIE

)t
gl

31« f) 145 5 (Build Variables) B #ET1
Sy AN E N\ Variables”, J7 & 4,

REEAR F S VPRSI H e I A T AR e

— BERURIR Y AR AR e OIS FH RSO

%ﬁiﬂj‘ , ,'{—:T\I:_'_:I‘“OK”

"F
= CfC+H+
(= Build
Build ¥ariables
(= Editor
Hovers
Syntax Coloring
=i Run/Debug
String Substitution

Build Yariables

@

PV R R A R A B,

e = Tl
Marne
Tvpe:

[] shiows system variables

$& 1) controlSUITER H S R4 &

Yariable name: | controlSUITE

String D

CHTIcontrolSUITE|

Cancel l

oK kl[

ai

DOIT

[Restore Defaulks ] [ Apply l

[ Ok H Cancel ]
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CPUJE R a8 JEH A 8RR 2|

« F7JFWindows Explorer {31 . 51
C:\TI\controlSUITE\device_support\f2806x\v110\F2806x_common\source

LT Y S HE T R CCS Y

Project Explorer#i1& 1 (1181 1t H
F2806x_CodeStartBranch

.asm
F2806x_CpuTimers.c
F2806x_Defaultlsr.c
F2806x_PieCitrl.c
F2806x_PieVect.c
F2806x_SysCtrl.c
F2806x_usDelay.asm

=

]

PR LA
£ ==
=522 BlinkingLED
+ #@b Binaries
H- [l Includes

+-[= ~Docs

[ F2806%_FLASH
[ F2E06:_RAM
#-|.g| BlinkingLED-DevInit_FZE06x.c
+l-|.g| BlinkingLED-Main.c

- [$4 F2806x_CodeStartBranch, asm
+- |y F2806x_GlobalvariableDefs.c

#| g F2806:x_Headers_nonBIOS.cmd
#| g F2E06x_RAM_ElinkingLED MO
[€]' Fza06x_FLASH_BlinkingLED, CMD
|=| macros,ini_initial

[T TMS320F28069.coxml [Ackive]

s

==

- [ Inclu
+-| g 2069 0EM_Ink.crnd

%] Experimenter's Kit - Piccola F28069, coxml [Ackive]

o -

= =08 'D TI Resour] -
Packad
URL:

File and Folder Tasks 2

&y Move the selected items
) Copy the selected items

€} FPublish the selected irems
to the web

(2) E-mail the selected items
¥ Delete the selected items

Other Places

<«

<«

Details

DOIT»‘

Marne
[Z] Fza06%_adc.c
e

[Z] Fza06x_Camp.c

mm

F2806x_CSMPasswords, asm
F2806x_DBGIER., asm

F2806x _DisInt.asm
Fz806x_Dma.c

=| F2806x_ECan.c

_1 F2806%_ECap.c

1 F2806x_EPwm.c
F2806x_EQep.c
F2806x%_Gpio.c
F2806%_HRCap.c
Fzg06x_I2C.c
F2a06%_Mcbsp.c
F2a06x_MemCopy.c
F2806x_OscComp.c

73 (o (o o oy

[ (3 3 o 3

F2806x _Sei.c
F2B806x%_Spi.c
F2806:x_sWPrioritizedDef aultL,.
F2806:x_SWPrioritizedPieYect.c

F2806x _TempSensorCony.c

T 3 T Y

i3 TEXAS
INSTRUMENTS

= Sovvee
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CPUJE R a8 JEH A 8RR 2|

o —ANTEHERE I, ARIA S S ARSI ek B s 2T H
— PR 2 3 (Link to files)”
— JERQE BER M AH X E (Create link locations relative to)”
o 8T FH AT 1B 1 8 A L BT U AR = CcontrolSUITED
— s E”

o {3 “HEEE (Link) B BRI S8 H BLAEProject Explorert
| XobilEperation 31

Select hiow files should be imparted into the project:

() Copy files
(%) Lirk to Files

= 1= CPUTimer
H- il Includes

7 . : . :
[v] Create link locations relative to: | PROJECT_LOC % | 26069 RAM_Ink.cd

CG_TOOL_ROOT

Confiqure Drag and Drop Settings... ECLIPSE HOME + F2806x_CodeStartBranch. asm
) CS_BASE_ROOT +- |6 F2806x_CpuTimers.c
LL_,.' EXTERMAL_BUILD _ARTIFACT :] H- |y F2806x_DefaulIsy.c
WORKSPACE—LOC +- Ll F2ENAY Pier kel -
PARENT_LnZ I

CCS_IMSTALL_ROOT
PROJECT Lz

I ) f Edit Wariables, .. %

el

T
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CPUSZIN 28 HPJR S #F S 31T 4

o JUAHTR A5 AR I A P o B S0
C:\TI\controlSUITE\device_support\f2806x\wv110\F2806x_examples\cpu_timer\Example_2806xCpuTimer.c
— C:\TNcontrolSUITE\device_support\f2806x\v110\F2806x_headers\source\F2806x_GlobalVariableDefs.c
— C:\TNcontrolSUITE\device_support\f2806x\v110\F2806x_headers\cmd\F2806x_Headers_nonBIOS.cmd
—  C:\TNcontrolSUITEMibs\math\IQmath\v15c\lib\rts2800_fpu32_fast_supplement.lib
—  C:\TNcontrolSUITEMibs\math\FPUfastRTS\\VV100\Mib\IQmath_fpu32.lib

L™ Project Explorer 23 — ‘?fp ¥ =0

55 BlinkingLED
== CPUTimer
H- il Includes
4 ZE069_RAM_Ink.crmd
[ & Example_2806xCpuTimer.c
|55 F2806x_CodeStartBranch, asm
[ F2E06%_CpuTimers,c
[ Feangs_DefaulIsr.c
[ F2a0ex_clobalvariablebefs, c
4m F2806%_Headers_nonBIOS,crd
[g F2E06x_PieCtrl.c
[ & F2E06x_Pievect.c
[ & F2E06x_SysChrl.c
% Fza06x_usDelay.asm
@ Expetimenter's Kit - Piccola F28069, coxml [Ackive]
Er 1omath_fpu3z.lib
B rks2800_fpu3z _fast_supplement.lib

] O O = R oy Y O O R Y = IO oy B
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CPUSZIN 28 HPJR S #F S 31T 4

- 4 %@ﬁ%ﬁ A, JF R & (Properties)
VR A7 (Location) Z 2 ann] 5 | FH B 82 055 10 AR &

e Hyyuzpilzs fur Ecuiule

= Build
= Z2000 Compiler
Basic Options
Assembler Options
Command Files
Defaulk File Extensions
Diagnaostic Options

ARGz

= B[]

Resource =l v
Path: ICPUTimeExample_Z806xCpuTimer,

Type: Linked File

Location: Nevice _supportif2806:iy1 101F2506x_examplesicpu_timerExample_2806xCpuTimer.c

Resolved location: )\ TIhconkrolSUITE device_suppaortiF2806:xv 1 101F2806x_examplesicpu_timer\Example_2806xCpuTimer .
Sizes f,338 bytes
Last modified: April 12, 2011 10:40:54 AM
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CPUSE 8% : BB

- AR RSN E IR R
o TEGRTRARH A (Include Options)” =,

=\
r‘ D
S—

LT BRERNINBERIIR

—  ${controlSUITE}device_support\f2806x\v110\F2806x_headers\include
—  ${controlSUITE}device_support\f2806x\v110\F2806x_common\include
—  ${controlSUITERibs\math\IQmath\v15c\include

- ${controISUITE}\I|bs\math\FPUfastRTS\VlOO\lncIude

. ‘${<BUILD VARIABLE>}’ /& £ T
H e P m A P A AR e [ T

= Buﬂd Configuration: | Debug [ Active ]
=I- C2000 Compiler
Easic Options
Assembler Options
Command Files
Defaulk File Extensions
Diagnaoskic Options
Directory Specifier
Entry/Exit Hook Cplions
File Type Specifier
Include Options
Language Opkions
Language Options: MISRA Rules
Library Function Assumptions
Optimizations
Parser Preprocessing Options
Predefined Symbols
Funtime Model Options
+- C2000 Linker
Debug

Specify a preinclude File {--preinclude)

Add dir ko #include se

"${controlSUITE} device _supporti F2806:x\v 1 LF2806x_headersiinclude"
"${controlSUITEY device_support) F2806:xv1 10V F2806x_commontincude”
"${controlSUITE}libsimathiIomathivl Sciinchude”

o controlSUITER ibsimath\FPUFastR TS 100%include”

a’"

DOIT»‘

[Manage Configurations. ..

]

£ & F Gl d

o
'\‘?,' Show advanced settings

[

oK ] [ Cancel ]

i3 TEXAS
INSTRUMENTS




1ETS.
oIt

CPUSERY 58 : i H i

o FTHFTUR - >HER P U (Resource -> Linked Resource)”#e & 2|10 H Fr A HE42 10 %%
TR AR AR
— X BRI E D H JZ AN LA X R gt ) AR
o TAEXZE _E TR I s e A s Ly R
o (EXH T UgwiRARE, HECR RS kA HER (FAEAem H S04
AnropertiesforGriiimen 1=

G 3 8

Linked Resources A=) v
=I- Resource (—
Path Yariables | |inked Resources
Resource Filters Path wariables specify locations in the file system, including other path wariables with the syntax "§4varL",
General The locations of linked resources may be specified relative to these path variables,
= Build Defined path wariables for resource "CPUTimer";

= C2000 Compiler

) i Marme Yalue Mew, .,
Basic Options
Assembler Options [==CC5_BASE_ROOT CATINCCSS, 1coswSicrs_base),
cammand Files = CCS_INSTALL_ROOT CATIICCSYE, sy
Default File Extensions = CE_TOOL_ROOT COTICCSY S, Vcosw S bools\ compiler,c 2000
Diagnostic Options [=ECLIPSE_HOME COTICCSYE, coswShedipse),
Directory Specifier = PAREMT L A TIHworkspacesisl
Entry/Exit Hook, Options [=PROIECT L C3 TIhworkspacests IWCPUTimer

File Type Specifier (= ACE L e T aces151
Include Options [=-controlSUITE A TIconkralSUITE

Language Oplions
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CPUJER 4% : U H A

G 3 8

OOIT

BEEE I B2 YR > (Linked Resources) i i~ BT A B a2 21 10 H ) S
B A2 DA Al R g A 2 RV R 4o 0] 42 0 R HE P

n] DS “Z 4 (Edit)... F B A5 Ao 42
PE n] LU I < (Convert) .. 424, - R 48T FH 48 0] B 12

| (=]/E3

Linked Resources gl -

SO EN ESH OGN NTTTET

=I-Resource I ——
Path Yariables | Linked Resources
Resource Filkers
General
= Build

Linked resources in project "CPUTimer";

Resource Mame Location

=[] variable Relative Lacation

= C2000 Compiler
Basic Options
Assembler Cptions
Cammand Files
Default File Extensions
Diagnostic Options
Direckory Specifier
Entry/Exit Hook Options
File Type Specifier
Include Options
Language Options

Language Options: MISRA Rules
Library Function Assumptions

Optimizations

\c| Example_z806xCpuTimer.c

5] Fz&06x_CodestartBranch. asm
L& F2806x_CpuTimers.c

|| FZanex_DefaultIsr.c

|c| Fz&06x_GlobalvariableDefs.c
¢ F2806x%_Headers_nonBICS,cmd
\c| Fz&06x_PieCrl.c

|| F2E0ex_Pievect.c

|| F2a06x_SwsCtrl o

5] Fz@0ex_usDelay.asm

B Iomath_fpu3z.lib

B rts2800_fpus2_fast_supplement.lib

controlSUITE device _supportif2806: v 1 10\F2806:_examplesicpu_timer\Example_2806:xCpuTimer.c
controlSUITE device _supportif2a06: v 1 10VF2806:x_commonisource\F2a06:x_CodeStartBranch. asm
controlSUITE \device_supportiF2806:x w1 104F2806x_commonlsourcelF2a06:x_CpuTimers.c
conkrolSUITE device_supporthF2806: 1 104F2806x _common’sourcel F2a06:x_Defaultlsr.c
controlSUITEVdevice _supportifF2806: v 1 1OVF2806x _headers\sourcelF2a06:_GlobalvariableDefs.c
controlSUITE \device _supportif2a806:x v 1 10VF2806x_headers\crmd\F2806:x_Headers_nonBIOS. crnd
controlSUITE N device _supportiF2806: v 1 10\F2806:_common’source\F2a06x_PieCtrl.c
controlSUITE \device _support\f280e:x w1 104F2806x _commonlsourcelF2806:x_Pievect.c
conkrolSUITE device_supporthF2806:y 1 10YF2806x _commonisourcel F2E06:x_SysCkrl c
controlSUITE \device _supportif2806: v 1 1OVF2806:x _commonisource\F2a06:x_usDelay, asm
controlSUITENBs mathiIQmathiv15cilib IQmath_fpu3z.lib

controlSUITENiBsimath\FPUFastRTS1Y 1004ibrts2800_fpu3Z_Fast_supplement.lib
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CPUERTSS : TN

o JTIRy >Ry AR R
(Build->Build Variable) >k 7
B IHE A =
— BOAIEOL L, HAIH 2

A AR K4 A Y
— A« W R 4048 (Show
system variables)” & L HE

KRAEFAE LA R RGN
BRI AL

o VERTAFX RO AR
= IAESIFR

N
| {
gy

aroperitiesuonGEEI e

Build

= Resource
Linked Resources
Resource Filters

Configuration: | Debug [ Active ]

1S,
oIt

8 (=1[E9)

- =

Manage Configurations. ..

General
= Build
CZD;:;:QE:;;S Build Steps | %] Build Variables | B Enwvironment | “% Link Order | o2 Dependencies
Assembler Options
Command Files e Twpe Valllluj ; (toolsf o]
} . CE_TOOL_ROOT  Direckory CUTILCCEYS, 1 focsy S toalsfcampiler fcz2000

Default File Extensions CG_TOOL_SUFFIX  String 2000

Diagnostic Options CLASSPATH String List . || €:\Program Files\R ationallClearQuesticaini...

Directory Specifier CLIEMTHAME String Consale

Entry/Exit Hook Options COM_TLRTSC ... String <ECLIPSE DYMAMIC YARIABLE >

File Type Specifier COM_TI_RTSC ... Skring <ECLIPSE DYMAMIC YARIABLE =

Include Options COM_TI_RTSC_... String <ECLIPSE DYRAMIC YARIABLE =

Language Options COMTTT LA ... Sing SECLIPaE DYNAMIC VARIABLE S 3

. _TI_UIA_IM... String < >

Lénguage Op.tlons. MISR"_" Rules COM_TI_XDAIS... 3htring <ECLIPSE DYMAMIC YARIABLE >

len.ar?.f FL_mCt'On Assumptions CommonProgra...  Skring Z3\Program FilesyCommon Files

Cptimizations COMPUTERMAME  String TOROKISOOLAP

Parser Preprocessing Options ComSpec String C INDOWSsystem32icmd, exe

Predefined Symbols ConfigDescription  Skring

Runtirme Madel Options Lonbighl ) =

+- 2000 Linker = i " . %
Debug WD Str!ng [« :'I,TI'l,work;paces'l,S 1GREECPUTimerDebug

DOK_IMSTALL_DIR  String CACCSkudio_v3. 3mgt_1_21
DEWMGR _SHOW. .. Skring True
DEWMGR _SHOW,. .. String 1
DirectoryDelimiter  Skring I

V] Show system variables

See 'General far changing compiler version and device settings

e
'\‘?,' Show advanced settings

[ Restore Defaulks ] [ Apply ]

[ Ok, H Cancel ]
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MESTHERZNZEE

o TENIATLITE, FRATE B4 7t i 1) #1148 72 (Linked Resource Path
Variables) fl«#) 1t 45 & (Build Variables) n] LALE T [H 2% il 1% &
o L TAEDX G i B IX L6 AR 5 PUARHE I H Pl 152 B 1 I Ab 2 A4 2
— PrA W H #AT AR ST H A A AR G E— 00

- ANFEEBESIE !
o RXONHYETE S T HAF BRI H dEH B8, DAOBE o AN H (checkouts), AT
ZIH 5 A !
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{

4

A2 - $RAZ(Check In)BfE2 4?2

« CCSIH T2 N A 1l 22 A~ XA S 52
— .CPROJECT F1.PROJECT /&Eclipsesit H SCF, FEM$HEAS
— .CCSPROJECT & CCSH¥) H 4RI H 3CA4, NEEAL.
— .settings —/MFRtfEIEClipse Uk, Hrp R B T H IIRE . NHeAS

B e
— launches FAE BB TIR AU AR PG H 3. SR KGRI H e, Bt
P TEN

— T BCESCIERINE G/ A  (Debug/Release) AN AT HEAC

Marne Size Type
) .settings File Folder
\_)Debug File Folder

Jcosprojeck 1 KB (CCSPROJECT File
.cprojeck 17 KB CPROJECT File
project 4 KE PROIECT File
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Eclipset&: £8 ki(Focus) clipse

£ TR TAE S Ik 5B AF
— A Edwmiaay, MK, —IiH, 5%,

o XAMMESIREHL, [KhZEEclipse i) )L N EAE S o ) A2 5 ok
— WHMEE R, wHE, SRR EAR, 5%,

[ Project Explarer E@‘ <=1'={> ¥ =0

=55 BlinkingLED

ﬁ',‘ Binaries

Includes

E— reDocs

(= F2806%_FLASH

(2 F2a06x_RAM

E] BlinkingLED-DewInit_Fz&06:x,c

#- [€ BlinkingLED-Main.c

[% F2806:_CodeStartEranch. asm

E‘}! Fz606x_GlobalvariableDefs,c

. % F2806:_Headers_nonBIOS.cmd

. @ F2806x_RamM_BlinkingLED . CMD

""" E' Fza0e:_FLASH_BlinkingLED . CMD

------ . macros.ini_initial

------ . TMS320F28069, coxml [Ackive]

= '[f:ﬁ- CPUTimer [Active - Debug]
"fﬁ. Binaries
Eﬂ Includes
E&- Debug Q
[ % 28069_RAM_Ink.cmd
. E‘}! Example 2ED6xCpuT|mer C

L T O N T

SddV
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BENNEER ‘55?1

« WHIN’CPU Timer’ W H C 2R IH, AJ51% I Debug’ #24

-

e LS s B Y e T L] E S O T NS e T

File Edit WYiew Mavigate Project Tools Scripts  Window  Help
[~ AL SN R IR A - Y

L™ Project Explorer &2 = = B | (/) TI Resource Ex
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SE AR
REAL-TIME MODE




fEHSERRR: BE

« FEHFR
— WS InAR B B «3R 1k 50 (Expressions) 1 &
— Ja AR R 2O H & 2L T (Continuous Refresh)
— W E SR AR RS R RREET T4
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4 B SERR?

o Hiril W FFEN T AU M8 GRS a7 2 55)
— T, R R iy s (- (silently halt)iz 47 FR KA PR SS - B3hE 1k
CPU, HUB AWAE, AR HIKIeqT
o IXAZEAECCS3.3M1, HIBAria T I B oyl 5 i A (watch) & 1 IRAT A -
o WIS —NSEIE RS , KR S ) B (glitch) . AR,
IR FE LB T H YR 4 R s, R LR AN A A A AN T T
o SERRLEUE —FIAECPUISATAATARS H, ]l LUE R NAFRIFN R ZF A7 TN 2%,
AR 55 H W s AR,
— H P RnT LIZEIER e (non-time critical) SRR, R TC T4 HL AR &%
[ ) DBt b
— ATERARE GHE MRS ERD

13 TEXAS
INSTRUMENTS




v5 ik 2R Bl (expression view)

e 21 55517

“Example 2806xCpuTimer.c”

— Highlight
“CpuTimer0.InterruptCount”, £ %5
oy, ARG EFE A I LA
(Add Watch Expression) e

AR B VAR R IE AL
EIY=F

— CpuTimerl.InterruptCount (255647
)

— CpuTimer2.InterruptCount (5747)

F ISP ET O (Watch Window)R I 22 &

GG e ERs e ey i E S i e T T e e o ENCoT oS eI o)

TS,
“ooiT

File Edit Wiew Search Project Tools Run  Scripts  Window  Help
Nwil (e @ - B0 e- ARl R
%5 Debug 52 Ok IS g G- @Y =0

= &%) CPUTimer [Code Composer Studio - Devics Debugging]

=g Texas Instruments ¥DS100v1 USE Emulator)C28x (Suspended)
main{} at Example_2&06xCpuTimer, ;77 0x005540
_args_main) 0x005600 {_args_main has only skeletal de
><@ Texas Instruments XDS100v1 USE EmulatariCL connected | Unknown)

urce Explorer .¢] Example_z806xCpuTimer.c £2

a6 /f Prototype statements for functig '==>I Run ko Line
67 interrupt void cpu timer0® isr(void) b Move i
65 interrupt void cpu timerl isr [voi

g2 interrunt void cpu timer2 isrivoid)

9= yariables |G Expressions 52

Expression

)= CouTimerd, Interrupt Cou
2R Add e S XOFERR0N

=

46/ / $End Boot Table
47/
43/
43 f/ Description:
5077
5177 This exammple configures CPU TimerO, 1, and 2 and incremsnts
52/ a counter each time the timer asserts an interrupt.
53 /7
T Watch Variahles:
55 /7 CpuTimerd., InterruptCount
56/ CpuTimerl. Interruptiourn
5747 CpuTimerz . IntercuptCoun Breakpoint {Code Composer Studio) 4
5874 cut Chrh+x
B0 S S HEHHHHREA TR R Copy ChleC HHEHHHHEERE
60 // 4TI Release: Z2306x C/C++ Header

. Paste Chrl+Y
61// 4Release Date: ALpril 7, 2011 3
G2 /S HEBHE RSB R E RSB R Declarations v RHEEEEE R
63 References 4
64 finclude "DIEPZ8x_Project.h” I Search Text » [nolude File
55

Ctri+R
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RIEAME . ES

>N

2l

.

(Continuous Refresh)

o LR E MRS AL K
— BRI 18] b 2 5002 5
— BRI Il T Be 2 mT A & Y

o Jo FIRELERUHTAEC, DI A2 B o AN W AE R a4 7 I S I Rl

()= Yariables &7 Expressions ©2 M Registers

Expression Tvpe
()= CpuTimerD, InkerruptbiZount unsigned long
()= CpuTimer 1, InterrupbCounk unsigned long
()= CpuTimerz, InterrupbCounk unsigned long

5P Add nes exprarmion

=k 5 | 4

Yalue
1
1
1

Address

Qx00004A11Z@Data
Qx0000A10Z@Data
00004 10A@Daka

UOIT

i3 TEXAS
INSTRUMENTS




BIE

N —a

(™

.-i/ﬁ

» JREsE

>f-‘}

—\N

‘4

fi A

Fr

— g

A}
(=S

R, SRIE R B ToVA BE it 4k

UOIT

Wl ) 4EL

LU, H AR 20 B>

1 ECCSVin] H brA7-fit 2

v (e g - HUR ey E sy e g S8 e - Euds dupiugazy Sigediy J J LE
File Edit Wiew Search Project Tools Run  Scripts  Window  Help
i B @-0 5 e- TR R I | #5 o5 Debug | 5 CC5 Edit
%5 Debug &2 00 = - o5 @ 7 T 0O 9= varisbles |G Expressions 52 | 018 Registers +k 3 & A -
= ¢! cPUTImer [Code Compaser Studio - Device Debugging] Expression Type Yalue Address
¥ Tewas Instruments ¥DE100v1 LISE EmulaborfC26:xx (Running; ()= CpuTimer0, InterrupbCount unknown Error: execution skate prevented access
fé’ Texas Instruments XD3100v 1 LSS EmulatorCLA_0 (Disconnected @ Unknown) ()= CpuTimer1, InterrupkCount unknown Ertor: execution skate prevented access
()= CpuTimer2, InterrupkbCount unknown Erraor: execution skate prevented access

a8 Add new exprassion

[ |
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K

| 13 >

CHT AR
Bk FbR, 48R S

UOIT

Hf A5 QR A 1 A SR T W A%

VIR

2% @ {(Be)e - T
%% Debug &2 Ok S L R T =7 0 9= variables | G5 23 0 Registers
= k¢! CPUTimer [Code Composer Studio - Device Debugging] Expression Type
=g Texas Instruments XD5100v1 USE Emulator fC28:x: (Suspended) ()= CpuTimer0. InterruptCaunt unisig
= main{} at Example_2806xCpuTimer.c: 77 0x008540 ()= CpuTimer1.InterruptCaunt unsig
= _args_main) 0x008600 {_args_main has only skeletal debug info) ()= CpuTimer2. InterruptCount unsig
x@ Texas Inskruments ¥03100v1 USE Erulator/CLA_0 (Disconnecked @ Unknown) SR Add new expression
L ERaE N T ELAUTIE I Sl S I L RS R O LS X 31_
LE:J TI Resource Explorer @ Example_Z806xCpuTimer.c
Do vl want to enable realtime mode?
46 /7 iEnd FBoot Table w-./ Can't enter realtime mode unless debug events are enabled,
Bit 1 of 5T1 musk be 0.
47 f
45 ff
49 /f Description:
EOS
BE1// Thizs example configures CPU %ﬁf%%mgj}%{
Bz /S a counter each time the time N
RN
534/
g // Watch Variables: Yes Mo
55 ff CpuTimerd. InterruptCon
i3 TExas
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SERHRRIEAT e

BT
WE Ik AL, BEMRCPU R I 45 o I i AR B 0 A 6 ) 1
o SRR VFCCSHE HARE AT 0 1) 21 H A5 A7-ff 4

Se G0 Haitd - Rz e 2 B80S i Tzre - Suds Capiuusdy Sy JJLE
File Edit ‘“iew Search Project Tools Run  Scripts  Window  Help
: [ - B g BB e B TR - R I | #5, ccs Debug | B ccs Edit
%% Debug 77 00 @ & @ 7 T O (9= variables | 5 Expressions ©2 | M5 Regist%s =5 @ | == A I e o B
= &'« CPUTimer [Code Composer Studio - Device Debugging] Expression Type Walue Address
B ()= CpuTimerd, InterrupkCount unsigned long 4 0x00004112@0ata
x@ Texas Instruments X05100v1 USE Emulator{CLA&_0 (Disconnected @ Unknown ) 9= CpuTimer1.InterruptCount unsigned long 4 0x00004102@0ata
()= CpuTimer2, InterrupkCount unsigned long 4 0000041 0&@0aks

a7 Add new expression
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i TR 55 A A A
DEBUG SERVER SCRIPTING




ARG ARHA: &I

. EHHF
- MRS A (DSS)
_ JEATDSSH Tloadti”
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ARG SRHA: BiR

& Debug - Code Composer Essentials

(Bf=1%]

Fle Edt Refoctor Navigate Search Project

g Rul o &

%5 Debug 11

L AN RN A
=5 Device

=@ Thread [main] (suspended)
<symbal i ot avalables= Dx00FFF04
3] €85+ Func Sim{TMS320C55¢p
#1 €SSt Func SmfTMSa20CSS<ps CI0

Console | Tasks | Pragress | [} Disasserbly &2
» 0x0OLLLE04 0000
0X0OLEL£06 0000
0X00£E££08 D00000DOO0000000
0x00££££10 D000000000000000
0x00££££18 0000000000000000
0X0OELEE£20 D0000DDOO00000OO
0X00LL££26 D00000DOO00000OO
0X0OLL££30 D000000000000000
0X00LL££38 D00000DOO000000O

Terget Rin Scope Window Help

¥-0- Q- & A= 4 C
(24 Resource
= | 3tit regsters 57 |Memory | Modlles | Breakpaints | variables

= f C55x+ Func 5imfTMS320C55xp [Non-Project Debug Session]

Em Value
e _m CPU Registers

= 33 status Registers

= it 57055 03500
- DF[15:7] 00
0 acon 00
0 ACOuD 00
- CARRY [
6010 it
<
Location: | Enter locationhere [w | [[2] 7 <&
nop_16
nop_16

.ivee #0x000000, <imvalid>|DATA_PTR_WORD
.ivec #0x000000, <invalid>|DATA_PTR_VORD
.ivec #Dx000000, <invalid>|DATA_PTR_WORD
.ivec #0x000000, <invalid>|DATA_PTR_WORD
.ives #0x000000, <invalids|DATA_PTR_WORD
.ivec #0x000000, <invalid>|DATA_PTR_WORD
.ivec #0x000000, <invalid>|DATA_PTR_VORD

=0

>
&0
=0

~

CCS:
I TEclipse ) A A5

efclipse

B3 Command Pmmpl

-[ax]

RET
Ty nnddmds 8 nLength: 500 sFile:
h: ENIR Nsinewave\sine .

a
RN e o 1o B A8 0 o 10 Mg Serverscript ingnexanplesnh

_\sineuave\sine.dat

: Lnadlng memory contents f£rom f£ile

R

ENIRY nAddvess: @ nPag nLength: 500 sFile sinevave\dunp.dat nIQForn)
false

ENTRY pathName: .\sinewave\dump.d;

RE 1.6,

TURN C:\tiToolsxDSE. 42 h e hugSeruemeeniptinghexamplesnCy

: B nAddress: Bx8 nNumllords @
Calculating size of a Word
Word Size its
ENIRY nFag

588 hSigned: false

nAddres nlypeSize: 32 nNumValues: 508 hSigned: fal
validating page

Ualidating start address

Getting memory ohject from debug session

Setting start addbess: Bx@

Setting buffer length: 26808

Reading ugcs) fron target

Generating 508 element Java array From raw memory buffer

RETURN L[J01673948

RETURN [J0167d940

test_nenC)
sty

session from the DebugServer

Unregistering this
0:1]

It

Scripting (Java)

DebugServer.DLL (C++)

DSS:
b A FR A
HEA GUIEK #ii
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HRRFASHA: HH

o fT ARG S AR 2
— WSS CHlds) —%Java AP
— A A AR A D g B Bl

o At afEE?
— H A FEIR
— SCRFERE A I8 BT A CPUI N #%

o A PLIE SRS =07 T EA L, i
— Javascript (i#IZRhino )
— Perl GEid<inline: Java”ft)
— Python (i#iidJython)
— TCL C#@idJacl/ Tclblend)

TEXAS

INSTRUMENTS




DSS vs. CCS A

« DSS;E#iiCCScripting 1)L 15
— P GRAGUIRHFEY, fERFEHEIT)
— FEORORI B PR 4R 1) H 75 (logging)
— ¥ (exception) &b #
o BIATT 4bFEDSS APIsHl H (1) 55
— HEHIHRARSSERE (BHRIISGUD
o 037 DSS) 2 b 42 4 (1) CCStudio 22358 i 75 (1) 45 i) /MR 22
— BEede, W TR ENAE AL EAE
— [RIIEAT 2N A S
— A LAMCCS- Eclipsefs 2 B B4 il 15 1) S HF .
— HHEMAPISZEE 6 GELRY K H#5)
o 5B L EREAPI
o B N ARAT AP + X5 JE I ST AE S R )
« CCS XffI/0 API GiHRIHD
o ATKIHISZF: Git&ilr)
— Linux FSCEF
 CCSIH A ZWin32/COM
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DSS:E R

« WHGUIR BB G GUIKITES)
— A VB 2 R S

o SOf—LEAPIFFES R D

o (ERERR AT
— CCScripting 7& 5 CCSA[a] )k N ia 4T
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DSS: &% (Benchmarks)

- Ja3h Uazhiiik#s)
— CCScripting: —5F)
— DSSf#): —1#

« FEIFINZAPI
— CCScriptingtt DSS APITERE [ IN#i 2t — 4R 145
« FHDSS />4 i) 4] out 3L 75 B — 652270
o [AIFE RIS UL CCSeripting 75 2 — 450
o TEFE AP 52 B2 0 TS L N B xR
— DSS: n#200¢%k =—13f
— CCScripting: JZ%200/x =—800%}
— DSSHiE T —1247%!
- %#I:/M\%U [ A | JNCCScriptingiZ % 2IDSS /53 N T 1.54% 3365 1
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DSS: = (Logging)

« XML&, (F T

— A LR E FEXMLICA 1 5 FH BXS T LS £
o BE H AL FHWebitl 3T I, 45 S B )7k
« XSTL#FE: http://www.w3schools.com/xsl/xsl_intro.asp

- TZEE
- I
RREER G delta (45)
—RA T

- HEMCIOHH
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DSS: HiZE: £EmRXMLAE

<?xml version="1.0" encoding="windows-1252" standalone="no"?>
<?xml-stylesheet type="text/xsl" href="SimpleTransform.xsl"?>

<log> ———— — '\\\\\\\\
<record>

<date>2007-05-02T15:30:15</date> ,Tﬁﬁﬁ FI/(]XS
<millis>1178134215917</millis>
<sequence>0</sequence>
<logger>com. ti</logger>
<level>FINER</level>
<class>com. ti.ccstudio.scripting.environment.ScriptingEnvironment</class>
<method>traceSetConsoleLevel</method>
<thread>10</thread>
<message>RETURN</message>
</record>
<record>
<date>2007-05-02T15:30:15</date>
<millis>1178134215917</millis>
<sequence>1</sequence>
<logger>com. ti</logger>
<level>FINER</level>
<class>com. ti.ccstudio.scripting.environment.ScriptingEnvironment</class>
<method>getServer</method>
<thread>10</thread>
<message>ENTRY sServerName: LegacySetupServer.l</message>
</record>

TLC 1
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DSS

=

FIASN

: A

Debug Server Log

Total Execution Timme: 89517 ms

Sequence

Ch| Lh| e B

10
11
12

13

Tune Delta
(ms) (ms)
0

0 0

0 0

10 10
10 0

a0 10
50 30
50 0

50 0

S0 0
2865 2815
4166 1301
6260 2094
£260 |0

Level Method

Message

FIMEE. traceseti”onsoleLewvel EETTTETT

FIMEE. |getServer
FIMEE. |getServer
FIMEE. |getServer
FIMNEE. |getZerver
FIMNEE. start
FIMEE. start

FINEE. |getServer

FIMNEE. |cosConfigClear
FIMNEE. |cosConfigClear
FIMNEE. |ccsConfigClear
FINEE. |ccsConfigClear
FIMNEE. |cceiZonfigClear

FIMNEE. |cosConfiglnport

ENTEY sServerMame: Legacysetuperver. 1
Fetting definition for: LegacySetupServer. 1
Constructing server

mtarting server

ENTEY

EETTTEI

EETITEI
cotn tt. debug engine scripting Legacysetup Server(@2534 95

ENTEY

Creating system setup object
Clearing configurations
saving system configuration
EETUEI

EMNTEY sConfig:
CADE S DebugServer'dnversimp ot DREALE 1] endian sum cos
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DSS: FH b3

o LGUI (A M ILHER %)

o [T APIFEE BEE R INH 2 Pl —NJavade
— 0] DAFE AR R Ab B S (filinJavascriptftry - catch)

% TEXAS
INSTRUMENTS




gz==

DSS: FEALE

« DSS AP H Javast i
o FST] DLRIAS H Ab HE A, A EAIC S S A R M Bl 4k 2

try {
debugSession.memory.loadProgram(testProgFile) ;
} catch (ex) {
errCode = dssErrorHdl.getLastErrorID() ;
dssScriptEnv.traceWrite ("errCode: " + errCode + " - " +
testProgFile + " does not exist!");

quit();

}
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DSS: i i A

o DSSHIHRhinoE k28, &l .
- ii; H‘ﬁ){_:—'\’ ﬁ%ﬂﬂlz‘gﬁ% .

- Hthing dvascript ebusser

BCCApE. tracelegin (" Ci /TEAR Test.xul”, "0 STLACIRS/CCIvd/Debugierver focTipting e

#f Log everything
#cTipt. traceSetlonmolelevel (Toacelevel. INFO)
script. traceSetllleleve ] (Tracelevel, LLL)

Ff Get the Debug Jerver and start & Debug Session

2 debugServer = script.getServer(“Debugiecver. ™)
21 B deboagServer, setlontiq|"C: /TL ACSANS TR vd  conmon/ Ear petadb Acond i parations /S tinin_cd
gheasicn = Frecver, cpenSession|. )

SF Load & progoan

£F |ScpiptingEnvizonaent has a concept of a working folder and for all of the AR
#F path nases 82 arpaents §ou can either pass & celatiwe path or an abaclute pati
debugiessicn. menory, losdfrogras [ “C: ACStudio_w3, J/cutor ial/s s inddoc ‘aaxainmeths deb!

(31 /7 A1l done
32 debagSesver.sEopi)

Conteod: =CTERPHew? j5, line 21 -|! Exprassion
T ] AR sonipl com B.cestudio scrpdng amironmant Ecnipting

= Froio [bject Obpec] -
| arguments | -

&= parenl__ object global]

o __prota :

length o
o Ay [functen Arin) | jritve code for Array Asray, ai
o= Bogléan funciion Bool u_]nm:uunwranuhans
| &= Cadl Tunchon Gl § jnatve code for Call. Call, arity=
o ConBnizaion Tuncton Contruatond | [nate code for Cord .
ren f dnedses ende g LS
this | Locals Wiatch |: Evaluaba
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RhinoB) iR as

* J& )& 4~(Rhino)
— UK ERF] T dss.bat”  (<Z¢3& H %>\ cesvb\ ces_base\ scripting \ bin)

— B4 A G125 3) 3756517, EHEH#! RHINO SHELL! K !
RHINO_DEBUGGER!

DSS: 1#

4
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DSSHIZRHIHA (1)

// Import the DSS packages into our namespace to save on typing
importPackage (Packages.com. ti.debug.engine.scripting) ;
importPackage (Packages.com. ti.ccstudio.scripting.environment) ;
importPackage (Packages. java.lang) ;

// Modify these variables to match your environment. Use forward slashes
var ccs5InstallDir = "C:/Program Files/Texas Instruments";
var ccs5ScriptingLabDir = "C:/CCSWorkshop/labs/scripting";

// Create our scripting environment object - which is the main entry point
// into any script and the factory for creating other Scriptable Servers and Sessions

var script = ScriptingEnvironment.instance() ;

// Create a log file in the current directory to log script execution

script.traceBegin (ccs5ScriptinglabDir + "/test.xml", cecs5InstallDir +
"/ccsv5/ccs_base/scripting/examples/DefaultStylesheet.xsl") ;

// Set trace levels for console and logs
script. traceSetConsolelevel (TracelLevel. INFO) ;
script. traceSetFilelevel (TracelLevel .ALL) ;
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DSSHIZRHIHA (2)

// Get the Debug Server and start a Debug Session

debugServer = script.getServer ("DebugServer.1l") ;
debugServer.setConfig(ccs5ScriptinglabDir + "/c6416 le sim.ccxml");
debugSession = debugServer.openSession (".*") ;

// Load a program

debugSession.memory.loadProgram(ccs5ScriptinglabDir + "/mainapplication.out");

// Run the target
debugSession. target.run() ;

// All done
debugServer.stop() ;

script. traceWrite ("TEST SUCCEEDED!") ;
// Stop logging and exit.

script.traceEnd() ;
java.lang.System.exit (0) ;
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DSSHIZ~#: loadti

- DSSf#JavaScriptznfil, 15— NaATRET, © A BAZETIR B et _bnd/ie 47 nf U7 s
*. Out

 DSSIHBIT, (HJE R AR TR A0 H A

o 5 oy AR Z X GUIMH, A8 B — AN Wes | 0 B sk TR, - Poad e 28 0 Ik
(Sanity Tests) F14lLALEE [=] )= (Batch Regressions) i

o EESCRFAEA T REALE -
—  C /Obx#ERr H AT A A B4 il 5 FUHIAS H 35

— R i T H &
— AT EEAS I N R R L AR R A T 1k S BT B )
— LR TR
— MEWBIEARNAE, ARG ESE (R ZIRR)D
. =LAk
o KTloadti L 2407, 152 “README. TXT”

— <228 Hsk>\cesvb\ces_base\scripting\examples\loadti
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loadti: i21T ‘BlinkingLED.out’

4

KM IEAEIZ4THICCS
FIIF—4-DOSHr 2% H
5 2 “Blinking LED.out” F2 /¢ ¥ A7 &

— Location: <WORKSPACE>\BlinkingLED\F2806x_FLASH\BIlinkingLED.out

— >set PATH=%PATH%;<CCS INSTALL DIR>\ccsv5\ccs_base\scripting\examples\loadti

— T EIT<CCS_INSTALL_DIR>H ol 145 11 22 255 A7 B
— > loadti —h (for console help)
— > loadti —c .\TMS320F28069.ccxml BlinkingLED.out

WA T 5SROl S R R R 1
] LA SILD2 AR, R CAEIB AT

FZCTRL- CHf ik

UOIT

i
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DSS: &R

« DSS MediaWikif) SCRY EZERE) -
 http://processors.wiki.ti.com/index.php/Debug_Server_Scripting
«  DSS APIFSCHY:
<INSTALL DIR>\ccsv5\ccs_base\scripting\docs\GettingStarted.htm
o 4TI H S H T A MediaWiki SRS
 http://processors.wiki.ti.com/index.php/Projects_-
_Command_Line_Build/Create
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R

« CCSHm&1TH1E
o MK - >BIAEEH 4 View->Scripting Console

« WTABEE ML HIEL

— FETABALH B A\ 1 i 2 H 3) 58 D fié
o AT AR SO

— JS: > help <COMMAND>

« JavaScript#ishelln] LA ] 2] fr 5 [#)DSS API
o« IG5 1217 DSSIH AR

Gl B O B e X4
— TE*. jSSCAE A EE— N JavaScript PR AL
— n#Ek B & X #9JavaScript 344
« loadJSFile <fulli# 42>/ myCustomConsoleCmd.js
o ALK A H(ANIR), RruE 2 B34
— XK BORAT AT LRI & 9 H A BRI

x4l 4 (Scripting Console)

i
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4

= £3 Ao 5 -0

#Hl 6

Il { 3 / - IOMEMORY COFF IOHEHORY_FLOAL IOMEMORY HEX IOMEMORT INT
b %)L‘ - >Bl] T | ] VleW- IOMEMORY LONG PAGE_DATA PAGE_DATA BYTE FAGE_ID

. . PAGE_Io BYTE PAGE_PROGRAM PORT_EXTERN PORT_NOREWIND
>Scr| ptl ng Conso I e PORT_READ PORT_UPDATE PORT_WRITE addSrcSearchPath
asm3tepln asmI3teplut asmSteplver assertlictiveDd
bpVWiewId br bra buildProject
N cleanProject close closedllEditor cls
o TﬁTAB%Q%‘ I:”j ? ﬁJ% connect debugictiveProject debugWiewId
h— disViewId disablelog disconnect enablelog
o E‘Z /\ AL A eval execCmdFile exit explidd
TﬁTAB{fﬁH F[Iz]j iﬁu)\ﬁ/ﬂ nlj expRemove expRemovelll expWiewId halt
//\\ s, N I~ help launchTIDebugoger logadCoff loadData
? E Z\‘ij—-‘D}EEJjJ Hb loadJ2File loadEeyword loadProg loadRaw
maximize memFill memiewld Tl
mmEnak le mmRemowe mmReset modiViewId
openView rinConnect rinbisconnect rinList
[ ] *H 9% E/J I*él portcConnect
F”] t;? portDisconnect portlist print probViewId
projviewId readiord regVisewld reload
JS . > hel p <COM MAN D> reset restart rtdxBufferConfig rtdxConfigMode
rtdxlisable rtdxEnable rtdrGetConfig rtdxLogFile
rcdxTrace run runBenchmark run3vync
sawveCoff savelata saveRaw soonViewId
services seclutoFunToMain secWindowBuffer sroitepIn
sroiteplut sroiteplrer symLoad unloadd3File
unloadKeyword
Wiewld
js: help loadd3File
loadd3File(file,store)
Iescription: Load a JavaScript file or all the Javalcript files in the directory.
Arguments:
path — the JavaScript file or a directory.
store - [optional] true, store the file(s) to the preference, the script will auto

reload the next time the view is open.

js:>|
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HAEH &

o ARG FMIGELES /T T B3tk

o GELAYIR T—/ M it s ididft B (28 REH F— MR L
'

o JHAYEH G BER AT DA A B AR SRRy A0 A B 1 3 Sl ) 1
BN IR AR

o BIARTEHEFMMGELES AT BAA H & SLHHIA IS = 5.

— GEL: hotmenu<function>
— A4S . hotmenu.addJSFunction

4
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AR

/I Add entries to the 'Scripts’ menu DN S EenEe ||

R
Zr
op

hotmenu.addJSFunction(*'Launch TCI6488 Simulator, Little Endian®, *'tci6488_le_sim()"); Tools window  Help
hotmenu.addJSFunction(*'Launch TC16488 Simulator, Big Endian™, ""tci6488_be_sim()"); %
Launch TCIA4ES Simulakor, Big Endian

// Path to folder with target setup ccxml files

var setupConfigFileFolder = "'C:/Documents and Settings/login/user/CCSTargetConfigurations';

I configure for a TC16488 Symmetric Simulator, Little Endian
function tci6488_le_sim()

{
ds.setConfig(setupConfigFileFolder + **/tci6488_le_sim.ccxml*);

debugSessionCPU1 = ds.openSession(***"*, "'C64+_0");
debugSessionCPU2 = ds.openSession(****", "'C64+_1"");
debugSessionCPU3 = ds.openSession(****", "'C64+_2"");

Local {13 | Watch (17 | Registers (13| Memory (1) &3 =8
=gk E’ o =

sroStepiut sroitepirrer aywmLoacd
targetConfigViewld toi6d85 he sim toifdds le =1
unloadlaFile unloa ok Ca= vt

jEix CLoledSs
teifgd85 he sim teifgds85 le sim
j3ir LCi6466 | I
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Eclipsedfiff - A

« CCSv53:TEclipse, FrlH A A ERBIEE = 5 ffifh it £
— http://marketplace.eclipse.org/

« CCSv5A:T-Eclipse3.7
— N T AR, 1R XA IS DY R
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il I

| PN

>3

AlAs

Eclipseffiff - %

« fii FHEclipse 3 #r & Bl 2% (Update
Manager )
_ SFRH) - SRR (Help > SR

&

N _
Install New Software)>K 4
work with: | bype or select a site
Find more software by working with the "Available Software Sites" preferences,

P e (FRE MR Feut i (
U R L ) E‘k_‘zlg:[:‘m ﬁﬁ ,'{—:_( ( E % ) Nafg@ There is no site select1 e REnosToTy,

Mame: Target Managemnent

Location: | http://download eclipse.org/dsdp/tmjupdates)3.1 Archive. ..

[ Ok, H Cancel ]

Select Al ] [ Deselect Al

/_‘ A
[ J j:‘@ ﬁ Details
> = é/‘“’ I N V4 [/\ oy
- 1/ 7\5 |\ /4ﬁ ’ I:I Show only the latest versions of available software [Hide items that are already installed
y) I I - Group items by category Wwhat is already installed?
| ﬁ } i E ILLE‘J %J . \ CCSVS\eC I I pse [ shaw orly software applicable to target environment
\d ro p i n S i /f/;I: % Contact all update sites during install to find required software
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controlSTICK

« KT fi# ¥ 5228069 controlSTICKN, 2
— http://processors.wiki.ti.com/index.php/C2000 32-bit Real-Time MCU Training
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